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Digital Music Studio
Introduction

Introduction

Digital Music Studio is refined as a premier solution in audio production. You can 

work with Digital Music Studio in many different ways. In the related topics, 

you'll find directions to specific information to help you accomplish tasks in audio 

editing.  
 
Six applications are provided in Digital Music Studio, and they are:  

Audio Recorder 

Audio Converter 

Audio Editor 

Audio CD Burner 

Audio MP3 CD Burner 

Audio Grabber 

If you need some help, please read this User Guide, if you can not find something here 

or you need some explanation or assistance, please feel free to e-mail us via E-mail or 

visit our website - http://www.audioeditor.us.
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Digital Music Record Edit Burn Studio
How to buy Digital Music Record Edit Burn Studio

How to buy Digital Music Record Edit Burn Studio

As soon as you make your order, our resellers will verify it. Your order will most likely be processed 

within less than 1 hour, but in some VERY rare cases it may take resellers more than 24 hours to 

process your payment.  
 
The registration key will be automatically generated at our server and e-mailed to you immediately 

after we receive payment confirmation from our e-commerce reseller.  
 
Please do not worry if you haven't received the registration information right away. Delays usually 

occur due to the high security settings of spam filters used by our clients. Our message may be 

rejected as a spam message by the mail service you use.  
 
If you haven't got the registration message within several hours, feel free to contact our Support 

Teamvia email.  
 
If you have questions concerning our software, please send e-mail to: support@audioeditor.us. We 

always do our best to help you!

Why Digital Music Record Edit Burn Studio?

Save Time 

a. It is outstanding both in speed and audio quality.

b. The easy-to-use interface helps you catch on to the system quickly.
 
Save Money

a. It is your one-way ticket to audio converting, creating and burning. 

b. 30-day money-back guarantee if you are not satisfied with it!
 
All in one tool 

Do more with your digital media. Audio recorder, audio converter, audio editor, CD burner, 

MP3 CD burner and grabber are all supported by this powerful tool. 
 
Easy-to-use 

With step-by-step manual, Whether you are an experienced user or a beginner, the 

software will make the task of converting audio files a breeze! 
 

What will you have after purchase?
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Full version of Digital Music Record Edit Burn Studio 

Fun in unlimited audio editing, audio converting, audio recording, CD grabbing and audio 

burning. 
 
Customer care 

We are pleased to offer our care to meet your needs. We promise that any customer 

question will be replied within 1 business day! 
 
 

Is my order secure?

We promise the most secure purchase as we did for years. 

ShareItand RegNow, all these Digital Smart Software partners passed strict certification. We truly 

believe in 'Only by benefiting our customer can we benefit ourselves'. So your purchase security in 

Digital Smart Software is our top priority! Digital Smart Software has been involved in E-commerce 

for years. And through these years, we built up a secure online shopping system. You can enjoy the 

speed and convenience we offer. 
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Digital Music Studio
The user interface (Overview)

The user interface (Overview)

Digital Music Studio is refined as a premier solution in audio production. You can work with Digital Music 

Studio in many different ways. In the related topics, you'll find directions to specific information to help you 

accomplish tasks in audio editing.  
 
Six applications are provided in Digital Music Studio, and they are:  

Audio Recorder 

Audio Converter 

Audio Editor 

Audio CD Burner 

Audio MP3 CD Burner 

Audio Grabber 
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Audio Recorder
Introduction

Introduction

The Audio Recorder is an easy to use program, without bells and whistles, specially designed to 

digitize recordings of music cassettes, LPs or videos for example, after which they can be recorded on 

CD with help of your CD-recorder software. Of course the program can also be used for sound 

recording.

With the Audio Recorder you can digitize a sound recording to the hard disk, in a way that is suitable 

to record it on an audio CD. For other sound recording tasks, various recording sound qualities can be 

selected.

See also:

●     Making an audio CD of a video, music cassette or record
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Audio Recorder
Making an audio CD

Making an audio CD

The Audio Recorder provide you with an easy way to digitize audio recordings on videos, music 

cassettes or LP’s for example and to subsequently burn it on a CD with help of your CD-burning 

software. 
 
In the next topics you can read general information and tips, which may help you when making audio 

CDs:

●     Digital recordings

●     The CD-burning software

●     Sound quality

●     Copyrights

●     CD tracks

●     System requirements

See also:

●     Getting started with the Audio Recorder
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Audio Recorder
Digital recordings

Digital recordings

Audio CD’s contain digital information to reproduce sound. The digital information consists of strings 

of numbers, which encode the frequency and volume of sound. 
 
A music cassette or LP contains analog information to reproduce sound. 
 
Before you can make an audio CD from a music cassette or LP, the analog recording must first be 

digitized. This digitizing is what the Audio Recorder does, in cooperation with your sound card. The 

digital recording is saved to the hard disk as a WAV or MP3 file. A WAV or MP3 file can be recorded 

onto a CD with help of your CD-burning software. 
 
An audio CD can be compared with a hard disk that contains only digital sound files.
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Audio Recorder
CD-burning software

CD-burning software

With the Audio Recorder you can create digital WAV or MP3 sound files, which can be recorded onto a 

CD with help of your CD-burning software. 
 
Please refer to the documentation of your CD-burning software for the procedure on how to burn WAV 

or MP3 files on a CD. 
 
If you are making audio CDs that will also play back on regular audio CD players, then always use 

uncompressed WAV sound files, preferably recorded with Compact disc stereo sound quality. This 

ensures the highest possible sound quality for standard Audio CDs.
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Audio Recorder
Sound quality

Sound quality

Audio CDs are known to have a perfect sound quality. What actually means that a CD recording 

almost perfectly reproduces reality. 
 
When you digitize an LP or music cassette, the clicks and noise are digitized as well, for they are part 

of the sound that is produced. Using the filters in the Audio Recorder you can enhance the sound 

quality and make the presence of noise or clicks sound less disturbing. 
 
Because you will listen to a CD recording of your music cassettes and LP’s for a long time to come, 

you have to pay special attention to the following issues when digitizing:

●     Always make use of the best playback equipment you have.  

It is highly recommended to tear apart your living room audio set and to drag that perfect cassette 

player to your computer. 
 

●     If you are going to digitize recordings from a music cassette, then set your cassette player tape 

switch to the right type (Normal, Chrome, Metal, etc).  

Also verify that you playback with the same noise reduction system (Dolby B or C for example), that 

was used to make the cassette recording. 
 

●     LP’s must be cleaned and dusted well and preferably you must use a new pick-up needle. This 

reduces the chance for clicks and noise that will be difficult to filter out later. 
 

●     While digitizing, pay attention to the recording volume level in the Audio Recorder.  

A recording volume that is too high will distort the sound. See also: Setting the volume. 
 

●     Make sure you select the Compact Disc stereo CD quality (Mp3 format & Wav format) or 128kbps,  

44100hz, Stereo quality (Wma format) in the Audio Recorder "Settings-Output Format Settings" 

window if you want to create standard audio Compact Discs.  

It is also recommended to always save recordings on disk as uncompressed WAV files, especially if 

you are going to burn audio CD’s that need to play back on a regular audio CD player. 
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Audio Recorder
Copyrights

Copyrights

You are not required to pay copyright fees to artists or other copyright owners, when you make copies 

for private use of recordings you already own. 
 
You are required to pay copyright fees to artists or other copyright owners, if you sell copies to others 

or make copies available to others in any other way. You are also required to pay copyright fees to 

artists or other copyright owners, if you make copies of recordings you do not already own. 
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Audio Recorder
CD tracks

CD tracks

Audio CDs almost always contain more than one track, which makes it easy to search for a particular 

fragment, by choosing a certain track number on your CD player. 
 
When you are going to make an audio CD of digital recordings, you always need a separate digital 

sound file for each individual track. 
 
Most CD-burning hardware and software force a gap of two seconds in between the tracks on CD. To 

eliminate this 2-second gap, see if your CD-burning software has an option called ‘Disk-at-once’ or 

‘CD-at-once’. 
 
Most times, an LP or music cassette also contains multiple separated tracks, so that you can easily 

digitize each track one by one, or you can use the Audio Editor to separate tracks if you record an 

entire LP or cassette side at once. 
 
Sometimes however, the tracks or songs on an LP or cassette are concatenated without a pause in 

between, but instead run over into each other with applause for example. Also in this case, you can 

use the Audio Editor to neatly separate the digital recordings of those songs. 
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Audio Recorder
System requirements

System requirements

To be able to record an audio CD, your computer system must meet the following specifications:

CD burner with software

The Audio Recorder provides you with an easy way to digitize recordings of videos, music cassettes or 

LP’s. Besides that you need a CD burning device and CD-burning software, to record the digital sound 

files on CD. The CD-burning software is usually supplied with the CD burning device. 
 
With the Audio Recorder you can digitize a sound recording to the hard disk, in a way that is suitable 

to record it on an audio CD. For other sound recording tasks, various recording sound qualities can be 

selected.

Sound card 

To record music in a way that is suitable for an audio CD, your system must be equipped with a 16 

bits sound card. The sound card must have a Line-in connector to connect an LP or cassette player for 

example.

Free disk space  

The hard disk of your computer must have sufficient free space to be able to temporarily store the 

digital sound files you want to record on CD.  
 
For each second of Compact disc quality digital sound, you need approximately 172 KB of free disk 

space. That is approximately 10 megabyte for each minute.  

This is the case for recordings with CD stereo sound quality. The actual amount of required disk space 

depends on the selected recording quality (see Recording quality for more information). If you want to 

record everything on CD in one session, you must have enough free disk space to accommodate the 

total playing time of all tracks. The recordings of a full CD (approximately 74 minutes), require 

approximately 740 megabyte of free disk space! 

 TIPS: 

If your hard disk does not have enough free space to accommodate all of the tracks that must 

be burnt on CD, you can record one or more tracks in steps. In that case you must not close 

the ‘recording session’ of the audio CD before all tracks are recorded. As soon as a group of 

tracks is recorded on CD, you can free disk space by removing the sound files from disk with 

help of the Windows Explorer. You will then have disk space to digitize the next group of 

tracks and you continue this process until all tracks are burnt on CD. Please refer to the 

documentation of the CD burning software for more information on recording sessions. 
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Processor  

Your system must be equipped with at least a 300 MHz processor and 64-Mb memory, to be able to 

process the enormous amounts of data without problems.
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Audio Recorder
Quick tour

Quick tour

With the Sound Recorder you can digitize audio recordings on music cassettes, LP’s, videos or any 

other sound source, after which they can be burnt on CD with help of your CD-burning software. 
 
A new recording will be stored in a temporary file on the hard disk. When you click on the Stop 

button, the new recording will automatically be created. when you want to edit the recorded file, you 

can click the 'Edit Audio Files' button. It will automatically open your browser and take you to the 

download page of our Audio Editor, it is free for download.

Making a recording is very easy. Follow these 4 steps for a successful recording: 

●     Connecting the source

●     Selecting the desired recording quality

●     Setting the volume

●     Record

See also:

●     Did you know... (tips & tricks)

●     Fast keys
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Audio Recorder
Connecting the source

Connecting the source

To be able to make a digital recording of sound on music cassettes, LP’s or videos for example, you 

must connect the video recorder, cassette player or record player to the sound card in your computer. 
 
Every sound card is different in detail, so here we can only provide you with some general guidelines 

on how this is done. 

 TIPS: 

More information (including pictures) on connecting sound sources like an LP or cassette 

player to your computer, can be found on our Internet site at this address:  

http://www.audioeditor.us 

Here are some general guidelines: 

●     A cassette player or video recorder can usually be connected to the sound card directly through the 

Line In or Auxiliary input connector.  

On a cassette player you must connect the Out or Play output connectors to the sound card.  

On a video recorder you must connect the (stereo) audio output connector to the sound card. The 

audio output signal is usually available together with the video output signal on a so-called SCART 

output connector on the video recorder. Special cables are available at your retailer. 
 

●     The signal of a record player is usually too weak to be connected to the sound card directly and 

must be connected to the Line In or Auxiliary input connector of the sound card through an 

amplifier. 

You connect the record player to the amplifier and the amplifier to the sound card. Usually you can 

use the Rec Out output connector on the amplifier for the connection to the sound card. 
 

 TIPS: 

Do not connect a record player to the microphone input of the sound card! A microphone 

connection of a sound card is usually not stereo but mono and also the signal might be 

distorted because the microphone channel of the sound card is not designed for other 

sources but microphones. 

●     At Sound source in the Audio Recorder window you choose which input of the sound card must be 

recorded. Usually this is Auxiliary or Line In for recording the connected video recorder, cassette 

player or record player. You can of course also record from any of the other sources, like the 

microphone. Your sound card provides the kinds and naming of available sound sources and this will 

differ from one sound card to another.
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Audio Recorder
Selecting the desired recording quality

Selecting the desired recording quality 

Before you start recording, you have to select the desired sound quality of the recording in the Audio 

Recorder Settings window. 

MP3 Preset Quality: 

The easiest way of choosing a level of compression for your MP3 files is to use the Preset Quality 

slider.  
 
The Preset Quality slider allows you to choose from several levels of quality and resultant file sizes. As 

you choose higher quality, the file size goes up as well. On the other hand, lower quality presets will 

be smaller and easier to send over the Internet.

Preset Bit rate Mode LAME 

Phone 16 kbps Mono X

Shortwave 24 kbps Mono X

AM Radio 32 kbps Mono X

FM Radio* 96 kbps Stereo X (J-stereo)

Voice 64 kbps Mono X

Radio 112 kbps X Stereo

Tape 128 kbps X Stereo

Hi-Fi 160 kbps X Stereo

CD 192 kbps X Stereo

Studio 256 kbps X Stereo

The default is CD quality (192 kbps, Stereo). 
 
* Note that the FM Radio bit rate is higher than the next preset quality, which is Voice. Voice is @ 64 

kbps and FM Radio is @ 96 kbps. The reason that there is a discrepancy is because Voice is mono and 

FM Radio is stereo. If you were to divide the FM Radio bit rate in half, you would have 48 kbps per 

channel, which is lower than the Voice preset. 

WMA Quality: 

To get to the WMA File Options, go into the Settings and click the Output format - WMA tab.  

WMA is a second generation compressed audio format. 
 
The main option on this screen is the quality format, which is chosen by moving the slider. The 

possible settings are:
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Preset Bit rate Mode Frequency

1 16 kbps Mono 8,000 Hz 

2 32 kbps Stereo 22,050 Hz

3 48 kbps Mono 44,100 Hz

4 64 kbps Stereo 44,100 Hz

5 96 kbps Stereo 44,100 Hz

6 128 kbps Stereo 44,100 Hz (default)

7 192 kbps Stereo 44,100 Hz

WAV Quality: 

CD Quality: This is the most popular setting. Use this when creating WAV files for burning on custom 

audio cds. 

CD Quality

This is the most popular setting. If you are creating WAV files so that you  
can burn them on custom CD compilations, choose this option. It will ensure  
that any non-CD quality format WAVs and MP3 files are converted to CD quality  
compatible WAV files.  
 
CD quality format WAV files are 44,100 Hz, 16 bits, stereo.

Specific Settings: Choose this if you want the WAV files in a specific format. 

Specific Settings

The last alternative can be used for special situations where you need all your resultant 
WAV files to be in a specific format. For example, you can use this if you need all your 
WAV files to be mono. 
 
Sample Rate 
The sample rate is the number of sound points per second. For example, 22,050 Hz 
means that there will be 22,050 samples of sound data every second. You can also type in 
the sample rate if its not in the list. 
 
Mode 
Stereo means that the resultant files will have a left and right channel. Mono means that 
there is only one channel.  
 
Bits Per Sample 
Each sample is stored in a finite number of bits. The more bits you use, the less noise is 
introduced to the sound. However, the file size will also get bigger as higher bits per 
sample are used. The default is 16 bit. 8 bit sounds may sound noisy especially for subtle 
dynamic sounds.  

 TIPS: 

1. Note that the sound quality of the recording will never be better than the original quality of 

the sound source. A rule of thumb is to select the sound quality that most closely compares to 

the quality of the sound source. 
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2. If you are not sure what to choose, then always select Presets - CD Quality. 

Although it is possible, it does not make sense to record a telephone conversation using Presets - CD 

Quality in stereo. That would consume unnecessary disk space to accommodate the kind of detail 

that is not present in a telephone line. 

On the other hand, is also makes no sense to record a stereo compact disc using mono telephone 

recording quality, since that would discard most of the enhanced details from the music. 
 
Please note that the higher the selected sound quality, the more disk space is required to store the 

recording. 

If you have little disk space left, then this might be a reason to select a lower sound quality. 

The maximum possible duration of a recording with the selected sound quality is reported in the 

Sound Recorder window.
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Audio Recorder
Setting the volume

Setting the volume

Just like with recording on a cassette recorder, you must adjust the recording volume. 
 
1. Check that the sound source is correctly connected to the sound card and that the right source is 

selected. See Connecting the source for more information. 
 
2. Check that the speakers are switched on and that the volume is open. 
 
3. Play a loud fragment of the song you want to record, on the video recorder, cassette player or 

record player. Adjust the Volume in the Audio Recorder Settings - Recording Source window, such 

that the peak meters (located on the right-hand side of the volume controls) are hardly reaching the 

red zone. During the loudest fragments, the peak meters should hover in the yellow area. 
 
Some sound sources, like Digital CD sources, don’t have a volume control and in that case the volume 

control will be disabled. The volume will then automatically be at the correct level. 
 
Some sound cards don’t support separate control of the left and right sound channel volume. This 

does not necessarily mean that the recording will not be in stereo though, provided that you do select 

a stereo sound quality. 
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Audio Recorder
Record

Record

While recording you don’t have to pay attention to the exact moment the sound starts or ends. Later 

you can use the Audio Editor to easily cut off a starting pause that is too long or cut the recording into 

multiple tracks. 
 
1. Set the video recorder, the cassette player or the record player on stand-by at the beginning of the 

song you want to record. 
 
2. First start recording, by clicking on the red record button in the Audio Recorder. 
 
3. Now start playback of the song on the video recorder, cassette player or record player. 
 
4. While recording, please pay attention that the peak meters will not reach the red zone too often 

and too long. See also: Setting the Volume. 
 
5. When the song is finished, click on the stop button in the Audio Recorder window. When a 

recording ends with applause for example, then also record a large part of this applause. Later it can 

easily be faded away with the Audio Editor. 
 
Once recording has started, a button will show up that can be used to reset the recording and start 

over again. 
 
A new recording will be stored in a temporary file on the hard disk. When you click on the Stop button 

to stop recording, the new recording will automatically be created. when you want to edit the 

recorded file, you can click the 'Edit Audio Files' button. It will automatically open your browser and 

take you to the download page of our Audio Editor, it is free for download. 
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Audio Recorder
Audio Recorder keystrokes

Audio Recorder keystrokes

This is a list of the functions in the Audio Recorder, which can be operated by pressing certain keys on 

the keyboard: 
 

Key: Function:

F9 Start recording

F10 Stop recording

Space Pause / continue recording

Ctrl+O View recorded files

F2 Config settings

F1 Help
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Audio Recorder
Did you know

Did you know

... that the Sound Recorder can record from virtually any sound source that is audible 

through the computer speakers? 

Recording Internet broadcasts (streaming audio) 

Recording live performances 

... and that you can: 

Convert home study courses from tape to CD 

Publish MP3 sound files on the Internet or E-mail them to friends 

... and that most functions of the software are also accessible with keyboard keystrokes: 

Audio Recorder keystrokes 

... and that you can read more about: 

Making an audio CD 

Connecting cassette, tape or record-players 

Recording sound qualities 

Frequently asked questions 

 
Visit our site on the Internet as well: http://www.audioeditor.us 
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Audio Recorder
Frequently asked questions

Frequently asked questions 

Click on the question in the list below, to jump directly to the answer:

●     How do I connect the audio equipment to my PC?

●     Can I record an Internet broadcast through RealAudio?

●     The CD's I create with your recordings play back on my computer, but not on my home or car 

player. What is wrong?

●     I cannot open or save mp3 files. Why is this?

●     My recordings contain pops, skips or other distortions, while the original sounds fine. What is wrong?

●     I have no sound output, except from your program. Why is this?

●     Can I paste and merge pieces of sound in the Editor?

●     Why is the disk full so quickly?

●     Why is the amount of available disk space not decreasing after I recorded something?

Q: How do I connect the audio equipment to my PC?

A: We have created a separate page on this subject. 
Click here to go to that page.

TOP

Q: Can I record an Internet broadcast through RealAudio?

A: Yes. 
You can record from virtually any sound source that is audible through the computer 
speakers, including Internet broadcasts with RealAudio for example. 
Just make sure to follow these steps: 

1.  First start play-back of the Internet broadcast in the player you are using, 
like RealPlayer. 

2.  Wait for RealPlayer to start play-back. First it will download a couple of 
seconds of sound, before it starts play-back. 

3.  Then start the Sound Recorder and select the appropriate sound source. 
The names of the sound sources differ from one system to another, but the 
sound source for recording RealAudio play-back, is usually named Wave, 
Stereo Mix, What You Hear, or something in similar wording. 
The Sound Recorder will automatically select the appropriate recording 
quality if needed. 

4.  Start recording in the Sound Recorder. 
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Optionally you can restart play-back in RealPlayer, to record the whole sound 
clip from the beginning. 

Note that on certain computers you cannot change the recording quality to 

anything other than that of the sound quality of the Internet broadcast. 

Also on certain computers you will get an error message in RealPlayer, about not 

being able to access the sound card, if you started the Sound Recorder before 

starting play-back in the RealAudio player. In that case the selected recording 

quality in the Sound Recorder window does not match that of the Internet 

broadcast and then RealPlayer cannot access the sound card for play-back. Just 

follow the steps explained above, to resolve this conflict.

TOP

Q: The CD's I create with your recordings play back on my computer, but not on 
my home or car player. 
What is wrong?

A: If the CD's cannot be played back on a regular CD player, then this can have several 
reasons. 
The most common reason is that the CD was not created correctly with your CD-

burning software. Most CD players require the CD-recording-session to be closed. 

For more information on creating standard Audio CD's and CD-recording-sessions, 

please refer to the manual of your CD-burning software.

Another possibility is that you created a Data CD with the sound files. This kind of 

CD is not recognized by regular CD players. Make sure you create an Audio CD 

instead and to "close the session" on the CD.

TOP

Q: I cannot open or save mp3 files. Why is this?

A: You probably have an old version of the software installed. Older versions of the 
software made use of third-party mp3 codecs that are already installed on your 
computer for saving and opening mp3 files. 
Starting with version 3.0 we have included full mp3 and mp3PRO support, thus not 

depending on third-party mp3 codecs anymore.

TOP
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Q: My recordings contain pops, skips or other distortions, while the original 
sounds fine. What is wrong?

A: If your computer is sufficiently equipped (see System requirements), this could be 
caused by a defect in the sound card hardware, but most likely it is caused by a 
problem in the software driver of your sound card. 
The Sound Recorder is totally depending on the quality of the sound card hardware 
and software driver, for the digitizing process. 
Here are some recommendations and things to check, in order of likeliness that they 
cause the problem: 

1.  Check if there is an update available for the software driver of your sound 
card. 
Most manufacturers of sound cards have an Internet site where free updates 
can be downloaded. 

2.  Make sure that no other tasks are active on your computer, while you are 
recording. 
The activity of other tasks, could have a negative impact on the response 
time of other processes like the recording process, causing short skips and 
pops. 
Do not forget about the tasks sitting in the "system tray" of Windows. That is 
where the clock is displayed, at the bottom right hand of the screen. Usually 
this is where programs like virus scanners are active. 
Also, if you have a continuous Internet connection (through cable or (A)DSL 
for example), it is best to disconnect it while you are recording. 

3.  Check the hard disk light on your computer. 
While recording, it should blink just shortly every 2 or 3 seconds. If the light 
blinks constantly and if you constantly hear hard disk activity while you are 
recording, then the speed of your hard disk could be the problem. 
What might help then, is to de-fragment your hard disk. This can be done 
with the hard disk de-fragmentation tool that comes with Windows and it can 
be found in the Start menu under Programs / Accessories / System tools / 
Defragmentation. 

TOP

Q: I have no sound output, except from your program. 
Why is this?

A: The Sound Recorder and Editor both automatically make sure that the volume is set 
correctly when it starts, but other programs most times don't do this automatically. 
If you don't hear any sound when the Recorder or Editor is not running, then you can 
manually control the sound channels on your system with the Windows volume 
controls. 
To show the Windows volume controls, double click on the little speaker icon in the 
task bar of Windows (near the clock) and make sure that the volume slider for the 
Wave channel is not set too low or even muted.

TOP
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Q: Can I paste and merge pieces of sound in the Editor?

A: No. 
The primary purpose of the Sound Recorder and Editor, is to digitize and prepare 
existing recordings on vinyl or tape, before you record them as separate tracks on 
audio CD's. 
Pasting and merging pieces of sound, is used to create new sound effects and this is 
not what the Editor is designed for.

TOP

Q: Why is the disk full so quickly?

A: Sound files are very large files. Specially sound files that are suitable for making an 
audio CD take a lot of disk space, because they contain the information for two-
channel (stereo) sound with a frequency of 44.1 kHz. 
For each second of digital sound, you need approximately 172 Kb of free disk space. 
That is approximately 10 megabyte for each minute. 
Please note that the actual amount of required disk space depends on the selected 
recording quality. 
As soon as you have recorded the sound files on an audio CD, you can of course 
remove the files from disk again.

TOP

Q: Why is the amount of available disk space not decreasing after I recorded 
something?

A: A new recording is always stored on the hard disk as a temporary file. 
While recording, the amount of available disk space on the disk that is used to store 
the temporary file will decrease. 
This is indicated in the Sound Recorder window, as the time that the new recording 
can last before the disk will be full. 
After recording, when you save the new recording to another disk with the Sound 
Editor, the used space will be released on the disk that was used to store the 
temporary recording file and this space will then be reused for the next recording.

TOP
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Recording Internet broadcasts (streaming audio)

With the Audio Recorder you can record from virtually any sound source that is audible through the 

computer speakers, including Internet radio broadcasts (streaming audio) for example. Just make 

sure to follow these steps: 
 
1. First start playback of the Internet broadcast in the player you are using, like RealPlayer. 

2. Wait for RealPlayer to start playback. First it will download a couple of seconds of sound, before it 

starts playback. 

3. Then start the Sound Recorder and select the appropriate sound source. The names of the sound 

sources differ from one system to another, but the sound source for recording RealAudio playback, is 

usually named Wave, Stereo Mix, What You Hear, or something in similar wording. The Sound 

Recorder will automatically select the appropriate recording quality. 
 
4. Start recording in the Sound Recorder. Optionally you can restart playback in RealPlayer, to record 

the whole sound clip from the beginning. 
 
Note that on certain computers you cannot change the recording quality to anything other than that of 

the sound quality of the Internet broadcast while recording. 
 
Also on certain computers you will get an error message in RealPlayer, about not being able to access 

the sound card, if you started the Sound Recorder before starting play-back in the RealAudio player. 

In that case the selected recording quality in the Sound Recorder window does not match that of the 

Internet broadcast and then RealPlayer cannot access the sound card for playback. Just follow the 

steps explained above, to resolve this conflict. 
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Recording live performances

With the Audio Recorder you can also record live performances. There are a couple of options here: 

1. Connect a microphone to the Mic input of the computer or laptop and record the live 

performance directly from the Mic or Microphone sound source. On many computers the 

microphone input is mono and not stereo, so if you connect a stereo microphone (or two separate 

microphones with an adapter plug), the recording will only be in mono. If you see two separate 

volume sliders in the Sound Recorder window when you select the  

Mic or Microphone sound source, then you can record in stereo. 
 
2. Connect the Line-Out output on an external sound system or PA to the Line-In or Aux input 

on the computer and record from the Line-In, Aux or Auxiliary sound source. This is of course 

most appropriate with complex performances where some sort of sound system is already in 

place, like in theaters or concert halls. 
 
3. Record the live performance with other traditional equipment, like a cassette-, tape- or 

minidisk-recorder. Later these recordings can be transferred to your computer by connecting a 

cassette-, tape- or minidisk-player to the Line-In or Aux input on the computer and record from 

the Line-In, Aux or Auxiliary sound source. See Connecting cassette, tape or record-players as 

well.

Page 30



Audio Recorder
Convert home study courses from tape to CD

Convert home study courses from tape to CD

Many home study courses like language courses come with cassette tapes containing audible lesson 

material. Constantly having to wind and re-wind those tapes to find the right fragment can become 

very annoying and might even withhold you from completing the course. 
 
Converting those cassette tapes to CD is the solution! On a CD player you can more easily jump to 

the fragment you need and also makes it easier to replay the same fragment over and over. 
 
Record the tapes using the Audio Recorder and subsequently use the track-splitting options in the 

Audio Editor to create separate tracks of each lesson. 
 
You might even skip the step of burning the lessons on CD, but rather play them back in the Audio 

Editor. That makes it even easier to skip to the right lesson and to re-wind the last lesson.  
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Publish MP3 sound files on the Internet or E-mail them to friends

With the Sound Recorder and Editor you can record and save compressed MP3 sound files. 
 
Compressed MP3 sound files are most times small enough to publish on the Internet for download by 

others, or to send them as attachments in an E-mail message.  

You'd better not do this with uncompressed WAV sound files because they are very large end are 

impractical to download or receive by E-mail within a reasonable amount of time. Besides that, most 

E-mail providers have a limit on the E-mail attachment size. 
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Using the filters (AGC)

Sound cards use AGC (Automatic Gain Control) to improve recordings. 
 
The following properties allow to get or set parameters of AGC: High Level, Low Level, Attack Time. 
 
The volume will be decreased if the level is more then High Level. And the volume will be increased if 

the level is less then Low Level. The rate of the volume changing is equal to (20db / Attack Time). 

 

AGC Properties Details

High Level The level is in db. Varies from -92 to 0. This is the maximal allowed 
volume level.

Low Level The level is in db. Varies from -92 to 0. This is the minimal allowed 
volume level.

Attack Time The time for level change by 20 db, in ms.
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Using voice active system

The following picture shows how works the accu algorithm: 

 
 
If signal is below the Attack Level for more than Attack Time, that spot in the audio will be considered 

beginning of silence.  
 
If signal is above the Release Level for more than Release Time, that spot in the audio will be 

considered end of silence.  
 
Silence Definition  
 
For very quiet high quality audio, the Attack Level and Release Level value will be lower (like -60dB). 

For noisier audio, the value may be much higher (like -30dB).  
 
If audio is above this given threshold for more than the number of milliseconds given, audio will be 

considered valid, and not silence. Use higher values for Release Time to ignore short periods of audio 

(like clicks, static, or other noise). If this value is too high (above 200ms), short words may be 

skipped.  

 

Aucc Properties Details

Attack Level The level is in db. Varies from -92 to 0. the level of loudness for the 
starting point of recording. This is a level for non-silence detection.

Attack Time Time is in ms. The sounding time for the starting point of recording. 
This is time for non-silence detection.

Release Level The level is in db. Varies from -92 to 0. The level of loudness for the 
ending point of recording. This is a level for silence detection.

Release Time Time is in ms. The silence time for the ending point of recording. This 
is time for silence detection.
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Wave format

Wave files usually contain uncompressed PCM audio data.  
 
In some cases, it may be compressed PCM data in a format such as ADPCM, GSM or True-Speech.  
 
Wave files end in the 3 letter extension .wav. 
 
.WAV 
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MP3 format

MP3 files contain perceptually encoded sound data.  
 
The frequencies that humans cannot perceive are removed, although some audio purists say they can 

tell the difference between a high bit-rate MP3 and a Wave file.  
 
A typical MP3 is 10 times smaller than an equivalent WAV file. 
 
MP3 files usually end with .mp3. They are also used with .mp1, and .mp2 file extensions. 
 
.MP3 

.MP2 

.MP1 
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WMA format

WMA stands for Windows Media Audio. WMA files contain perceptually encoded sound data.  
 
The frequencies that humans cannot perceive are removed, although some audio purists say they can 

tell the difference between a high bit-rate WMA and a Wave file.  
 
A WMA file can be as much as 20 times smaller than an equivalent WAV file.  
 
.WMA 
 

Page 37



Audio Converter
Introduction

Introduction

Audio Converter's purpose is to audio files from one format to another according to your wish and 

saving them to your hard drive. The following audio formats are available for conversion: WAV(PCM), 

OGG Vorbis, MP3, MP2, Microsoft ADPCM, WMA, VOX, GSM, G723, G726, U-LAW, A-LAW, etc.  
 
Converting audio files Audio Converter user will find the opportunity to specify frequency, number of 

channels, bit rate and other parameters of output files. 
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System requirements

To be able to record an audio CD, your computer system must meet the following specifications:

1, Microsoft Windows 2000/XP/2003 (all of the last updates installed are recommended)  
 
2, Intel or AMD or compatible processors at 1000 MHz minimum  
 
3, RAM 128 megabytes (MB)  
 
4, Minimum 50 MB of free hard disk space (When you create an MP3 CD with folders and 

subfolders, it is required to create a disc image on your hard drive first. For this purpose you need 

to have approximately 700MB of free space on your hard drive for proper program performance.)  
 
5, Administrative permissions are required for installation  
 
6, Sound card  
 
7, CD-RW drive 
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How to proceed

Step1-Getting started

You can create a list of files you want to convert using the following buttons:

Button Shortcut Description

Add File
(s)... Ctrl + O Adds one or several files selected from the specific folder to the 

file list.

Play Source Ctrl + P Play the input file.

Select All Ctrl + A Select all the files in the file list.

Select None Ctrl + N Cancel the highlighted file from the file list.

Remove Del Removes the highlighted file from the file list.

Step2-Selecting output file

You can select the output file format in the Userface. It support more format: WAV, WMA, MP3, MP2, 

OGG, VOX, ADPCM, GSM，ect. 

Audio Converter will automatically locate all of the output files in My Music folder at your computer. 

You will be able to change output file location at Output Path in the Userface. For that click the 

Browse... button and select desired output file location. 

Step3-Setting and Converting process

You can specify the output file format parameters such as Frequency, Bitrate and Channels. 

Please note that it is possible to specify Fine tuning parameters for MP3  formats clicking the 

Advanced button. You can find the detailed information about these settings in the Appendix section. 

See also: 
 
Available MP3 Parameters Combinations  

Available MP2 Parameters Combinations  

Available Ogg Vorbis Parameters Combinations 

If everything looks alright to you please click the Convert button to start conversion. Note that there 

is an opportunity to close the program (or shut down windows) after converting process is finished. In 

case you don't want it, leave the check-box (See Setting->General Settings) unchecked. You can 

visually judge the completion of the grabbing process with the Progress Bar. 
 
You can also cancel converting process clicking the Cancel button Page 40
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Selecting the desired  file quality 

Before you start converting, you have to select the desired sound quality in the Audio Converter 

Settings window. 

MP3 Preset Quality: 

The easiest way of choosing a level of compression for your MP3 files is to use the Preset Quality 

slider.  
 
The Preset Quality slider allows you to choose from several levels of quality and resultant file sizes. As 

you choose higher quality, the file size goes up as well. On the other hand, lower quality presets will 

be smaller and easier to send over the Internet.

Preset Bit rate Mode LAME 

Phone 16 kbps Mono X

Shortwave 24 kbps Mono X

AM Radio 32 kbps Mono X

FM Radio* 96 kbps Stereo X (J-stereo)

Voice 64 kbps Mono X

Radio 112 kbps X Stereo

Tape 128 kbps X Stereo

Hi-Fi 160 kbps X Stereo

CD 192 kbps X Stereo

Studio 256 kbps X Stereo

The default is CD quality (192 kbps, Stereo). 
 
* Note that the FM Radio bit rate is higher than the next preset quality, which is Voice. Voice is @ 64 

kbps and FM Radio is @ 96 kbps. The reason that there is a discrepancy is because Voice is mono and 

FM Radio is stereo. If you were to divide the FM Radio bit rate in half, you would have 48 kbps per 

channel, which is lower than the Voice preset. 

WMA Quality: 

To get to the WMA File Options, go into the Settings and click the Output format - WMA tab.  

WMA is a second generation compressed audio format. 
 
The main option on this screen is the quality format, which is chosen by moving the slider. The 

possible settings are:
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Preset Bit rate Mode Frequency

1 16 kbps Mono 8,000 Hz 

2 32 kbps Stereo 22,050 Hz

3 48 kbps Mono 44,100 Hz

4 64 kbps Stereo 44,100 Hz

5 96 kbps Stereo 44,100 Hz

6 128 kbps Stereo 44,100 Hz (default)

7 192 kbps Stereo 44,100 Hz

WAV Quality: 

CD Quality: This is the most popular setting. Use this when creating WAV files for burning on custom 

audio cds. 

CD Quality

This is the most popular setting. If you are creating WAV files so that you  
can burn them on custom CD compilations, choose this option. It will ensure  
that any non-CD quality format WAVs and MP3 files are converted to CD quality  
compatible WAV files.  
 
CD quality format WAV files are 44,100 Hz, 16 bits, stereo.

Specific Settings: Choose this if you want the WAV files in a specific format. 

Specific Settings

The last alternative can be used for special situations where you need all your resultant 
WAV files to be in a specific format. For example, you can use this if you need all your 
WAV files to be mono. 
 
Sample Rate 
The sample rate is the number of sound points per second. For example, 22,050 Hz 
means that there will be 22,050 samples of sound data every second. You can also type in 
the sample rate if its not in the list. 
 
Mode 
Stereo means that the resultant files will have a left and right channel. Mono means that 
there is only one channel.  
 
Bits Per Sample 
Each sample is stored in a finite number of bits. The more bits you use, the less noise is 
introduced to the sound. However, the file size will also get bigger as higher bits per 
sample are used. The default is 16 bit. 8 bit sounds may sound noisy especially for subtle 
dynamic sounds.  

Please note that the higher the selected sound quality, the more disk space is required to store the 

converted files. 

If you have little disk space left, then this might be a reason to select a lower sound quality.
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MP3 advanced

MP3 Advanced window contains 4 tabs:

●     General

●     Filtering

●     VBR

●     Expert

General

At the General tab you can select the necessary Channels. The suggested choice includes the 

following variants: Stereo, Joint Stereo, Forced Joint Stereo, Dual Channels and Mono. See the 

description of each mode in the table below:

Channel Description 

Stereo 

In this mode, the encoder makes no use of potentially existing 
correlations between the two input channels. It can, however, 
negotiate the bit demand between both channels, i.e. give one 
channel more bits if the other contains silence.

Joint stereo 

In this mode, the encoder will make use of a correlation between both 
channels. The signal will be matrixed into a sum ("mid") and 
difference ("side") signal. For quasi-mono signals, this will give a 
significant gain in encoding quality. This mode does not destroy phase 
information like IS stereo that may be used by other encoders. This 
setting can be used to encode DOLBY ProLogic surround signals.

Forced Joint 
Stereo 

This mode will force MS joint stereo on all frames. It's faster and it 
uses some special mid and side masking threshold.

Dual Channels

In this mode, the 2 channels will be totally independently encoded. 
Each channel will have exactly half of the bitrate. This mode is 
designed for applications like dual languages encoding (for example: 
English in one channel and French in the other). Using this encoding 
mode for regular stereo files will result in a lower quality encoding.

Mono 
This option will generate a mono file, if the input file is a stereo file, 
the input stream will be downsampled to a mono file by averaging the 
left and right channel.

In the right part you will find the opportunity to set Encoder Quality. You can specify the output 

quality; thus you can trade off encoding time against sound quality. The default (normal) is 

recommended for the lower bit rates (<160 kbps), high quality for bit rates >160 kbps. The voice 

quality is more or less optimized to generate the best quality for voice
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There are some built-in presets you can use. They have for the most part been subject to and tuned 

via rigorous double blind listening tests to verify and achieve this objective. These are continually 

updated to coincide with the latest developments that occur and as a result should provide you with 

nearly the best quality currently possible. You can find them in Preset and Alt-Preset lists.

Presets available:

Phone, SW, AM, FM, Voice, Radio, Tape, HiFi, CD, Studio, R3Mix.

Alt-Presets available:

Preset Description

None Do not use any alt-presets 

Fast Standard 

VBR mode preset. It should generally be understandable to most 

people with most music and is already quite high in quality. The 

resulting bitrate should be within the 170-210 kbps range, 

according to music complexity. Enables the new fast VBR method 

for a Standard preset. Its disadvantage is that often the bitrate will 

be slightly higher than with the normal mode and quality may be 

slightly lower also.

Standard 

VBR mode preset. It should generally be understandable to most 

people with most music and is already quite high in quality. The 

resulting bitrate should be within the 170-210kbps range, according 

to music complexity.

Fast Extreme 

VBR mode preset. If you have extremely good hearing and similar 

equipment, this preset will provide slightly higher quality than the 

"standard" mode. The resulting bitrate should be within the 200-240 

kbps range, according to music complexity. The "fast"-option 

increases speed significantly but may give a tiny bit lower quality.

Extreme 

VBR mode preset. If you have extremely good hearing and similar 

equipment, this preset will provide slightly higher quality than the 

"standard" mode. The resulting bitrate should be within the 200-240 

kbps range, according to music complexity.

Insane 

CBR mode preset. The option gives you the current theoretical 

maximum quality possible. The output files are flat 320 kbps. Using 

this may be a little insane, since the difference in quality in between 

extreme and insane is minimal. However, if you simply don't care 

about file size, want maximum quality, or you have hardware that 

can't handle VBR files, then you could use this option.
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You can also select Mpeg Tag Version out of ID3 Ver.1 or ID3 Ver.2.

ID3 Ver.1

The audio format MPEG layer I, layer II and layer III (MP3) has no native way of saving information 

about the contents, except for some simple yes/no parameters like "private", "copyrighted" and 

"original home" (meaning this is the original file and not a copy). A solution to this problem was 

introduced with the program "Studio3" by Eric Kemp alias NamkraD in 1996. By adding a small chunk 

of extra data in the end of the file one could get the MP3 file to carry information about the audio and 

not just the audio itself.

The placement of the tag, as the data was called, was probably chosen as there were little chance 

that it should disturb decoders. In order to make it easy to detect a fixed size of 128 bytes was 

chosen. The tag has the following layout (as hinted by the scheme to the right):

Song title 30 characters

Artist 30 characters

Album 30 characters

Year 4 characters

Comment 30 characters

Genre 1 byte

If one sums the size of all these fields we see that 30+30+30+4+30+1 equals 125 bytes and not 128 

bytes. The missing three bytes can be found at the very beginning of the tag, before the song title. 

These three bytes are always "TAG" and is the identification that this is indeed a ID3 tag. The easiest 

way to find a ID3v1/1.1 tag is to look for the word "TAG" 128 bytes from the end of a file.

As all artists doesn't have a 30 character name it is said that if there is some bytes left after the 

information is entered in the field, those bytes should be file with the binary value 0. You might also 

think that you cannot write that much in the genre field, being one byte big, but it is more clever than 

that. The byte value you enter in the genre field corresponds to a value in a predefined list. The list 

that Eric Kemp created had 80 entries, ranging from 0 to 79.

ID3 Ver.2

ID3v2 is a new tagging system that lets you put enriching and relevant information about your audio 

files within them. In more down to earth terms, ID3v2 is a chunk of data prepended to the binary 
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audio data. Each ID3v2 tag holds one or more smaller chunks of information, called frames. These 

frames can contain any kind of information and data you could think of such as title, album, 

performer, website, lyrics, equalizer presets, pictures etc. The block scheme to the right is an example 

of how the layout of a typical ID3v2 tagged audio file may look like.

One of the design goals were that the ID3v2 should be very flexible and expandable. It is very easy to 

add new functions to the ID3v2 tag, because, just like in HTML, all parsers will ignore any information 

they don't recognize. Since each frame can be 16MB and the entire tag can be 256MB you'll probably 

never again be in the same situation as when you tried to write a useful comment in the old ID3 being 

limited to 30 characters.

Speaking of characters, the ID3v2 supports Unicode so even if you use the Bopomofo character set 

you'll be able to write in your native language. You can also include in which language you're writing 

so that one file might contain e.g. the same lyrics but in different languages.

Even though the tag supports a lot of byte consuming capabilities like inline pictures and even the 

possibility to include any other file, ID3v2 still tries to use the bytes as efficient as possibly. If you 

convert an ID3v1 tag to an ID3v2 tag it is even likely that the new tag will be smaller. If you convert 

an ID3v1 tag where all fields are full (that is, all 30 characters are used in every field) to an ID3v2 tag 

it will be 56 bytes bigger. This is the worst case scenario for ID3v1 to ID3v2 conversion.

Since it's so easy to implement new functionality into ID3v2, one can hope that we'll see a lot of 

creative uses for ID3v2 in the future. E.g. there is a built-in system for rating the music and counting 

how often you listen to a file, just to mention some brainstorm results that are included. This feature 

can be used to build playlists that play your favorite songs more often than others.

[Back to the top]

Filtering

Highpass Filter cuts the lowest frequencies and passes the highest. The Lowpass Filter allows only 

the lower frequencies to be present into the output signal; it will cut the beautiful crystal sound of a 

violin (frequencies over 10 KHz), but if it could amplify rather than just pass the low frequencies, than 

it would enhance your favorite disco music with lots of percussions and bass.

　

Highpass filtering frequency (in kHz): Frequencies below the specified one will be cut off.

Width of Highpass filter (in kHz): The width of the highpass filter. The default is 15% of the 

highpass frequency.

Lowpass filtering frequency (in kHz): Frequencies above the specified one will be cut off.

Width of Lowpass filter (in kHz): The width of the lowpass filter. The default is 15% of the lowpass 

frequency.
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Regarding to the Nyquist Sampling Theorem the sample rate have to be at least two times higher 

than the highest frequency of analog audio signal. For example, the human ear can detect sound 

across the frequency range of 20 Hz to 20 kHz. According to the sampling theorem, one should 

sample sound signals at least at 40 kHz in order for the reconstructed sound signal to be acceptable 

to the human ear.

So applying the low-pass analog filter to a file with sample rate of 8kHz you should take into 

consideration that the frequency parameter of this method have to be at least two times less ( < 4 

kHz) than the file's sample rate.

[Back to the top]

VBR

At VBR tab you should select Coding Method first. The description of each method you can find in the 

table below:

Coding 
Method Description 

None Don't use VBR, instead it is encoding with a Constant Bit Rate (CBR)

Default Use the default VBR method (currently set to VBR-MTRH )

Old The functional approach, based on maskings, bisection in the bit domain

New The approach, based on maskings and direct noise allocation

MTRH A merger of old and new (VBR) routine

ABR The Average Bit Rate (ABR) setting, the encoding principle is based on 
perceptual entropy, but more like CBR than VBR

　

Maximum VBR Bitrate: Allows to specify an maximum bitrate when using VBR (Variable Bit Rate), 

this selecting depends on what base bitrate you have chosen in the main encoder tab. It's 

recommended to leave this set to 320 kbit/s unless you want low quality VBR files.

VBR Quality: In VBR mode, you are able to specify a quality setting which will affect encoding bitrate 

allocation. If you use quality 0, the max bitrate will be reached easily, while using quality 9 the bitrate 

usually will be around the base bitrate. The lower the VBR quality value, the better the audio quality, 

but also the bigger the output file. Recommended setting for high quality VBR encoding is 1 or 0.

Write VBR Header: This tag is embedded in frame 0 of the MP3 file. It lets VBR aware players 

correctly seek and calculate playing times of VBR files.

Target bitrate for ABR: The allowed range of the ABR bitrate is 4 - 310 kbit/s, you can use any 

integer value within that range.

[Back to the top]
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Expert

At Expert tab you can find the opportunity to set the following options:

●     include CRC-Checksum  

When enabled, the encoder will calculate the cyclic redundancy check (CRC) for the MP3 frames, and 

will add the CRC value to the MP3 stream.

●     comply as much as possible to ISO MPEG spec  

With this option, the encoder will enforce the 7680 bit limitation on total frame size. This results in 

many wasted bits for high bitrate encodings.

●     allow block types to differ between channels  

Allows the left and right channels to use different block types. Normally this is not allowed, only 

because the FhG encoder does not seem to allow it either.

●     short blocks  

Encode all frames using short blocks.

●     bit reservoir  

Enable bit reservoir.

　

You can also set ATH Control function, useful for low volume. ATH is used to approximate an equal 

loudness curve. Select one of the suggested modes:

ATH Control 
Mode Description 

Default   

Only
This option ignores the output of the psy-model and only use masking 
from the ATH. Might be useful at very high bitrates or for testing the 
ATH.

Disabled
Disable any use of the ATH (absolute threshold of hearing) for 
masking. Normally, humans are unable to hear any sound below this 
threshold.

Only for short 
blocks Ignore psychoacoustic model for short blocks, use ATH only.

There are also three De-emphasis options: default, 0/15 microseconds and citt j.17.

[Back to the top]

Page 48



Audio Converter
Bitrate

Bitrate

Bitrate is defined as the number of data points used to approximate the true wave form. Obviously, 

the higher the number, the more accurately the wave form is approximated. 
 
For example, the current de facto standard is to encode MP3 at 192 kbps, or 192,000 bits per second. 

The CODEC takes the bitrate into consideration as it writes each frame to the bitstream. If the bitrate 

is low, the irrelevancy and redundancy criteria will be measured harshly, and more subtlety will be 

stripped out, resulting in a lower-quality product. If the bitrate is high, the codec will be applied with 

leniency, and the end result will sound better. Of course, the file size of the end product corresponds 

directly with the bitrate. 
 
192 kbps is an example of a constant bitrate (CBR) mode. Constant Bit Rate (CBR) encoding 

maintains the same bitrate throughout an encoded file. All that means is no matter what, there will 

always be 192 kbps written into the bitstream. If your audio has moments of silence, it is captured 

and encoded at that rate, as are areas of very diverse frequencies (that might sound better if encoded 

to a higher bitrate). 
 
Variable Bit Rate (VBR) is an MP3 encoding method that's used when file size is not an issue. As it's 

name implies, the bitrate is varied throughout the file. The codec guesses which parts could benefit 

from more bits per second, and which can use less. The result is a much higher quality file.
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Frequency

Sampling frequency also impacts fidelity. The sampling frequency is essentially the number of times 

the sound event is quantized within a given time period. Sampling frequencies are specified in 

KiloHertz (KHz), a term meaning samples per second. The key in understanding how sampling 

frequency affects fidelity is the Nyquist sampling theorem. Basically, when applied to audio signals the 

Nyquist theorem states that the highest possible pitch in the sound is one-half that of the sampling 

frequency. 
 
For example, "CD-quality" sound requires 16-bit words sampled at 44.1 KHz. Essentially this means 

44,100 16-bit words (705,600 bits) are used to digitally describe each second of sound on a compact 

disc. The highest pitch possible is 22.05 KHz (approximately the top of human hearing range), which 

is half of 44.1 KHz.
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Audio file formats

Audio Converter support the following audio codecs: 
 

Codec Description

ADPCM
Compressed WAV format. ADPCM (Adaptive Differential Pulse Code Modulation) is an audio compression scheme which 

compresses from 16-bit to 4-bit for a 4:1 compression ratio.

ALAW

Compressed WAV format. A-Law (or CCITT standard G.711) is an audio compression scheme common in telephony 

applications. It is a slight variation of the u-Law compression format, and is found in European systems. This encoding 

format compresses original 16-bit audio down to 8 bits (for a 2:1 compression ratio) with a dynamic range of about 13-

bits. Thus, a-law encoded waveforms have a higher s/n ratio than 8-bit PCM, but at the price of a bit more distortion than 

the original 16-bit audio. The quality is higher than you would get with 4-bit ADPCM formats. Encoding and decoding is 

rather fast and generally, widely supported.

DSP Compressed WAV format. DSP Group True Speech (TM) format.

GSM Compressed WAV format. Good for keeping human speech.

G.726 Used for computer telephony. Good for keeping human speech.

MP3 MPEG Layer-3 format. Very popular format for keeping music.

PCM
Standard Windows WAV format for non-compressed audio files. Pulse Code Modulation (PCM) is the standard method of 

digitally encoding audio. It is the basic uncompressed data format used in file types such as Windows .wav.

ULAW

Compressed WAV format. u-Law (or CCITT standard G.711) is an audio compression scheme and international standard in 

telephony applications. u-Law is very similar to A-Law, a variation of u-Law found in European systems. This encoding 

format compresses original 16-bit audio down to 8 bits (for a 2:1 compression ratio) with a dynamic range of about 13-

bits. Thus, u-Law encoded waveforms have a higher s/n ratio than 8-bit PCM, but at the price of a bit more distortion than 

the original 16-bit audio. The quality is higher than you would get with 4-bit ADPCM formats. Encoding and decoding is 

rather fast and generally, widely supported.

VOX

Dialogic ADPCM format. The Dialogic ADPCM format is commonly found in telephony applications, and has been optimized 

for low sample rate voice. It will only save mono 16-bit audio, and like other ADPCM formats, it compresses to 4-bits/

sample (for a 4:1 ratio). This format has no header, so any file format with the extension .VOX will be assumed to be in 

this format.

RAW Raw format of audio files. Doesn't contain header of an audio file.

WMA
Windows Media Audio format. A special type of advanced streaming format file for use with audio content encoded with the 

Windows Media Audio codec. The .wma extension indicates a file format and how the content is encoded.

CCIT U-Law Compressed WAV format.

Ogg Vorbis Ogg Vorbis format.
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MP3 format

MP3 files contain perceptually encoded sound data.  
 
The frequencies that humans cannot perceive are removed, although some audio purists say they can 

tell the difference between a high bit-rate MP3 and a Wave file.  
 
A typical MP3 is 10 times smaller than an equivalent WAV file. 
 
MP3 files usually end with .mp3. They are also used with .mp1, and .mp2 file extensions. 
 
.MP3 

.MP2 

.MP1 
 

Page 52



Audio Converter
Wave format

Wave format

Wave files usually contain uncompressed PCM audio data.  
 
In some cases, it may be compressed PCM data in a format such as ADPCM, GSM or True-Speech.  
 
Wave files end with the 3 letter extension .wav. 
 
.WAV 
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Audio converter keystrokes

This is a listing of the functions in the Audio Converter, which can be operated by pressing certain 

keys on the keyboard: 
 

Key: Function:

Ctrl + O Adds one or several files selected from the specific folder to the file list.

F9 Start converting

Ctrl + P Play source file

Alt+F4 Exit

Ctrl + A Select all files

Ctrl + N Select none

Del Delete select files from list

Ctrl + U Move up

Ctrl + D Move down

F1 Help
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Available mp2 parameters combinations

You can find the available MP2 parameters combinations in the table below:

Frequency 16 KHz 22.05 KHz 24 KHz 32 KHz 44.1 KHz 48 KHz

Bitrate mono stereo mono stereo mono stereo mono stereo mono stereo mono stereo

8
+  +  +        

16 + + + + + + 　 　 　 　 　 　

24 + + + + + + 　 　 　 　 　 　

32 + + + + + + + 　 + 　 + 　

40 + + + + + + + 　 + 　 + 　

48 + + + + + + + + + + + +

56 + + + + + + + + + + + +

64 + + + + + + + + + + + +

80 + + + + + + + + + + + +

96 + + + + + + + + + + + +

112 + + + + + + + + + + + +

128 + + + + + + + + + + + +

144 + + + + + + + + + + + +

160 + + + + + + + + + + + +

192 　 　 　 　 　 　 + + + + + +

224 　 　 　 　 　 　 + + + + + +

256 　 　 　 　 　 　 + + + + + +

320 　 　 　 　 　 　 + + + + + +

384 　 　 　 　 　 　 + + + + + +

MP2 supports all the combinations of the frequency and bitrate if the frequency varies from Minimum to Maximum values for the 

current supported bitrate.
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Available mp3 parameters combinations

You can find the available MP3 parameters combinations in the table below:

Frequency
MONO Stereo

Minimum Maximum Minimum Maximum

48 KHz 64 Kbps 320 Kbps 128 Kbps 320 Kbps

44 KHz 56 Kbps 320 Kbps 112 Kbps 320 Kbps

32 KHz 40 Kbps 320 Kbps 80 Kbps 320 Kbps

24 KHz 32 Kbps 160 Kbps 64 Kbps 160 Kbps

22 KHz 32 Kbps 160 Kbps 56 Kbps 160 Kbps

16 KHz 32 Kbps 160 Kbps 40 Kbps 160 Kbps

12 KHz 24 Kbps 160 Kbps 32 Kbps 160 Kbps

11 KHz 16 Kbps 160 Kbps 32 Kbps 160 Kbps

8 KHz 8 Kbps 160 Kbps 8 Kbps 160 Kbps

Frequency 8 KHz 11.025 KHz 16 KHz 22.05 KHz 24 KHz 32 KHz 44.1 KHz 48 KHz

Bitrate mono stereo mono stereo mono stereo mono stereo mono stereo mono stereo mono stereo mono stereo

8
+ + + 　 　 　 　 　 　 　 　 　 　 　 　 　

16 + + + + + + + + + 　 　 　 　 　 　 　

24 + + + + + + + + + + 　 　 　 　 　 　

32 + + + + + + + + + + + + + + + +

40 + + + + + + + + + + + + + + + +

48 + + + + + + + + + + + + + + + +

56 + + + + + + + + + + + + + + + +

64 + + + + + + + + + + + + + + + +

80 　 　 　 　 + + + + + + + + + + + +

96 　 　 　 　 + + + + + + + + + + + +

112 　 　 　 　 + + + + + + + + + + + +

128 　 　 　 　 + + + + + + + + + + + +

144 　 　 　 　 + + + + + + + + + + + +

160 　 　 　 　 + + + + + + + + + + + +

192 　 　 　 　 　 　 　 　 　 　 + + + + + +

224 　 　 　 　 　 　 　 　 　 　 + + + + + +

256 　 　 　 　 　 　 　 　 　 　 + + + + + +

320 　 　 　 　 　 　 　 　 　 　 + + + + + +

384 　 　 　 　 　 　 　 　 　 　 　 　 　 　 　 　

MP3 supports all the combinations of the frequency and bitrate if the bitrate varies from Minimum to Maximum values for the current supported frequency.

Page 56



Audio Converter
Available ogg parameters combinations

Available ogg parameters combinations

You can find the available ogg parameters combinations in the table below:

Frequency

Mono Stereo

Minimum Maximum Minimum Maximum

48 KHz 48 Kbps 192 Kbps 48 Kbps 320 Kbps

44 KHz 48 Kbps 128 Kbps 48 Kbps 256 Kbps

32 KHz 48 Kbps 112 Kbps 48 Kbps 192 Kbps

24 KHz 32 Kbps 56 Kbps 48 Kbps 160 Kbps

22 KHz 32 Kbps 56 Kbps 48 Kbps 160 Kbps

16 KHz 48 Kbps 96 Kbps 48 Kbps 192 Kbps

12 KHz 32 Kbps 48 Kbps 48 Kbps 96 Kbps

11 KHz 48 Kbps 48 Kbps 48 Kbps 64 Kbps

8 KHz 8 Kbps 24 Kbps 16 Kbps 48 Kbps

Ogg Vorbis supports all the combinations of the frequency and bitrate if the bitrate varies from 

Minimum to Maximum values for the current supported frequency.
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Introduction

Thank you for using Audio Editor! Audio Editor is a visual multifunctional audio files editor which allow 

you to perform various operations with audio data such as displaying a waveform image of an audio 

file, filtering, applying various audio effects, format conversion and more. Supports all major audio 

formats.

With Audio Editor you can

●     Open, create and save audio files; 
●     Display a waveform window of an audio file and apply zooming; 
●     Play an audio file or any part of it; 
●     Record new audio file from a microphone or another input device; 
●     Visually edit an audio file (Cut, Copy, Delete Silence, Paste, Paste From File, Mix, Mix From File); 
●     Apply different effects (Amplify, Delay, Equalizer, Fade, Flanger, Invert, Normalize, Reverse, Multi 

Tap Delay, Silence, Stretch, Vibrato, Echo, Chorus); 
●     Apply different filters to the selected part of an audio file (Ban Pass Filter, High Pass Filter, High 

Shelf Filter, Low Pass Filter, Low Shelf Filter, Notch Filter). 
●     Insert noise or silence in an audio file; 
●     Convert an audio file from one format to another; 
●     Use marker to locate the selected part or special part of the audio data; 
●     Insert and change information about an audio file (Album, Artist, Channels, Comments, Copyright, 

Genre, Title, Year). 

Audio Editor supports the following file formats

●     Uncompressed WAV PCM; 
●     Compressed WAV (GSM, ADPCM, DSP, U-Law, A-Law and others); 
●     MPEG2 Layer 3 (MP3), MPEG2 Layer 2 (MP2); 
●     WMA (Windows Media Audio); 
●     Ogg Vorbis; 
●     AIFF, AU; 
●     MPC (Music Pack); 
●     VOX (Dialogic ADPCM); 
●     RAW (Uncompressed PCM, U-Law, A-Law); 
●     G.726, G.723, G.721; 
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For New Users

1. I am a New User of audio editing. How do I start? 

  Step 1. Open an audio file; 

  Click Open button in the top toolbar to open audio file for editing. The audio data will show in the 

Wave View. 

  Step 2. Click and drag on the Wave View to select the part you want to edit; 

  Step 3. Edit the audio data; 

  Open the Edit, Operations and Filters menu item or click on the top toolbar to choose your action 

and edit the audio data. 

  Step 4. Save the audio data; 

  You can save the audio data as various format audio file. Click the Save button to save the 

whole audio data or click Save Selection As button to save the selection.

2. How to record sound from Microphone, DVD / VCD / CD Player, MP3 Player, 

RealPlayer, Windows Media Player, Web Page, Internet Conversation, Internet News, 

Internet Radio Station and the others? 

  Step 1. Select the Record Source; 

  Select 'Microphone' in the Record Source (Options -> Device Control -> Input Device) to record 

from Microphone. Select 'Stereo Mix' in the Record Source to record any sound from your sound 

card. 

  Step 2. Click the Record button to begin recording; 

  Step 3. Click Stop button to end recording; 

  Step 4. Save the audio data (or you can edit it before saving); 

  You can save the audio data as various format audio file. Click the Save button to save the 

whole audio data, click Save As button to save the whole audio data as with a different file name, 

type and location or click Save Selected As button to save the selection.
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Frequently asked questions 

Click on the question in the list below, to jump directly to the answer:

●     I am trying to use Audio Editor, but it is not working properly. What could be the problem?

●     How do I use Audio Editor to record from a LP or cassette?

●     I have attempted to download the software many times, but each time the download is more than 

the file size listed on the web site. Why am I having this problem?

●     I purchased a copy of Audio Editor, and now I want to use it on another computer. What can I do?

●     I have purchased a previous version of Audio Editor in the past. How do I upgrade to the new 

version?

●     Do you produce a version of Audio Editor for the Mac? 

●     Can I purchase the software in a local store near where I live? 

●     What is the update/upgrade policy for Audio Editor? 

●     What is Audio Editor's refund policy? 

●     Recommended Operating System configurations for Audio Editor 

●     Hardware Requirements for Audio Editor 

●     How do I uninstall Audio Editor? 

Q: I am trying to use Audio Editor, but it is not working properly. What could be 
the problem?

A: Audio Editor instability is caused by insufficient system resources. Audio Editor uses 
many system resources because it must load the uncompressed data from audio files 
at once for processing. Although, on most systems, 128 MB of RAM should be 
sufficient, depending on other hardware in the system, 256 MB might produce much 
better results. 

TOP

Q: How do I use Audio Editor to record from a LP or cassette?
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A: Audio Editor can be used to record from any available source. Therefore, you should 
make the necessary hardware connection from your stereo or other source device to 
your sound card. Now, within Audio Editor, select the connection used on your sound 
card as the input source for recording. Start playback on your stereo or other device, 
and click the record button on the Audio Editor window. When the audio content 
playback is complete, press Stop in Audio Editor, and save the recording via the Save 
As command. You should keep in mind the frequency at which recordings are saved. 

TOP

Q: I have attempted to download the software many times, but each time the 
download is more than the file size listed on the web site. Why am I having 
this problem?

A: This problem seems to occur only when using a download manager with specific 
network conditions. If at all possible, you will have better results by downloading the 
software normally through your browser. 

TOP

Q: I purchased a copy of Audio Editor, and now I want to use it on another 
computer. What can I do?

A: The software's license is for a single computer. If you'd like to use the software on an 
additional computer, you can upgrade your license for $29.95 to support this from 
http://www.audioeditor.us/ 

TOP

Q: I have purchased a previous version of Audio Editor in the past. How do I 
upgrade to the new version? 
Why is this?

A: You may upgrade to the new version of Audio Editor for free from the following URL: 
http://www.audioeditor.us/ 

TOP

Q: Do you produce a version of Audio Editor for the Mac? 
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A: No. 
Audio Editor Soft Development Team does not develop Macintosh software at this 
time. Unfortunately, as we are not familiar with the Macintosh software market, we 
do not know of a solution to recommend for similar operations on the Mac platform.

TOP

Q: Can I purchase the software in a local store near where I live? 

A: Audio Editor is not currently sold through retail distributors. We are using the try 
before you buy method of distribution at present which allows users to install the 
software and ensure it's what they're looking for before having to spend any money 
whatsoever. The software can be purchased from anywhere in the world, though, 
directly from the Audio Editor web site or via postal mail, fax, phone, or wire transfer.

TOP

Q: What is the update/upgrade policy for Audio Editor? 

A: When Audio Editor is purchased, all updates for the major version ordered can be 
downloaded and used free of charge.

TOP

Q: What is Audio Editor's refund policy? 

A: We are sure that you will be completely satisfied with the results and quality of Audio 
Editor. However, should the product fail to meet your expectations for any reason 
whatsoever within the first 30 DAYs, we will provide a 100% total refund.

TOP

Q: Recommended Operating System configurations for Audio Editor 

A: Windows 98, Windows ME, Windows 2000, or Windows XP, Windows 2003.

TOP
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Q: Hardware Requirements for Audio Editor 

A: Minimum: 

Intel® Pentium ® class 400 MHz processor or better; 128 MB RAM; 30 MB Hard 

Drive space; 12x CD-ROM drive or better (optional); Sound Blaster-compatible 

sound card and speakers/headphones; SVGA or higher color video display card 

(minimum resolution 800x600); Internet connection for ordering, and support. 

Recommended: 

Intel® Pentium® III class 800 MHz MMX or better; 256 MB RAM or more; 50 MB 

Hard Drive space; 48x CD-ROM drive; Sound Blaster-compatible sound card and 

speakers/headphones; 16-bit color video card; Internet connection for ordering, 

and support.

TOP

Q: How do I uninstall Audio Editor? 

A: To uninstall Audio Editor, click Start from the Windows Taskbar, go into Settings/
Control Panels/Add/Remove Programs and select Audio Editor from the Install/
Uninstall tab.

TOP
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Menu and Toolbar

 Tip: Most commands are available only if you have selected a portion of the audio file. To 
select a portion, click and drag the mouse pointer over an area in the display area of the Audio 

Editor Gold window, use Ctrl+A or double click the main editor window to select all region.

File Menu

New Create a new audio file

Open Open an existing audio file

Save Save the active audio file

Save As Save the active audio file with a new name

Save Selection As Save the selected part as a new audio file

Close Close current file

Exit Quit the application; prompts to save file

View Menu

Wave View Show audio data as wave format

Spectral View Show audio data as spectral format

Left Channel Enable or disable left channel

Right Channel Enable or disable right channel

Zoom In Zooms in for a more detailed view

Zoom Out Performs an operation opposite to Zoom In

Selection Tool Selects a specified region for the sound file

Zoom Full Displays the entire waveform in the window

Vertical Zoom In Vertical zoom in

Vertical Zoom Out Vertical zoom out

Horizontal Scale Format > Decimcal 
(m:ss.dddd) Change horizontal scale format to decimcal 

Horizontal Scale Format > Sample Change horizontal scale format to sample

Horizontal Scale Format > Visible Show/Hide horizontal scale

Vertical Scale Format > Sample Values Change vertical scale format to sample

Vertical Scale Format > Normalized 
Values Change vertical scale format to normalized 

\Vertical Scale Format > Decibel 
Values\ Change vertical scale format to decibel 

Vertical Scale Format > Visible Show/Hide vertical scale

Frequency Analysis Show frequency analysis window

Audio Information Show audio information window

Marker List Show marker list window

Bar Style Change bar styles

Play Menu

Play Stars the playback of a part of an audio file
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Play Loop Plays the selected region looped

Record
Starts recording from an input source of an 
input device to a new audio file or to the 
current position of an opened audio file

Pause Stops playback and leaves the cursor at the 
current location

Stop Stops playback

Seek To Start Sets the cursor position to the start of the 
sample, and select the region

Seek To End Sets the cursor position to the end of the 
sample, and select the region

Edit Menu

Undo Undo the last action

Redo Redo the previously undone action

Cut Cut the selection and put it on the Clipboard

Copy Copy the selection and put it in a temp file

Paste Insert copied contents

Crop Deletes all data outside of the current 
selection

Trim Adds trim effect to the selected parts of the 
audio file

Paste From File Insert contents from a audio file

Mix
Mixes the selected part of an audio file with 
copied contents [more]

Mix From File
Mixes the selected part of an audio file with 
another file [more]

Insert Silence Inserts some silence into the file at the start 
marker

Delete Deletes the selected part of an audio file

Silence Selection Silences the selected region

Select All Select the entire data

Operation Menu

Channel Converter Mix left/right channels [more]

Delete Silence
Deletes silence from the selected part of an 
audio file [more]

Fade In Fades in over the selected region [more]

Fade Out Fades out over the selected region [more]

Fade Custom Fades over the selected region [more]

Amplify
Applies Amplify effect to the selected part of 
an audio file [more]

Normalize
Normalizes the selected part of an audio file
[more]

Vibrato Adds vibrato to the selection [more]

Compressor Performs amplitude compression [more]

Stretch Time
Increase or decrease the speed of selected 
region [more]
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Pitch Shift
Adds itch shift effect to the selected part of 
an audio file[more]

Delay
Makes a delay effect in a selected part of an 
audio file [more]

Phaser
Applies phasing effect to the selected part of 
an audio file [more]

Flanger Adds a flanging effect to the selection [more]

Reverb Adds reverberation to the sound [more]

Chorus
Applies chorus effect to the selected part of 
an audio file [more]

Reverse Reverses the selected part of an audio file

Invert Inverts the selected part of an audio file

Noise Reduction Menu 

Cassette Noise Reduction
Applies cassette noise reduction effect to the 
selected part of an audio file[more]

Voice Breath Reduction
Applies voice breath reduction effect to the 
selected part of an audio file [more]

Expander
Applies expander effect to the selected part of 
an audio file[more]

Generate Menu

Insert Silence
Inserts some silence into the file at the start 
marker [more]

Add Noise
Add noise to the selected part of an audio file 
[more]

Filter Menu

Notch
Applies Notch Filter to the selected part of an 
audio file [more]

Band Pass
Applies Band Pass filter to the selected part of 
an audio file [more]

Low Pass
Applies Low Pass Filter to the selected part of 
an audio file [more]

High Pass
Applies High Pass Filter to the selected part of 
an audio file [more]

Low Shelf
Applies Low Shelf Filter to the selected part of 
an audio file [more]

High Shelf
Applies High Shelf Filter to the selected part 
of an audio file [more]

Help Menu

Help Contents Displays the table of contents for the online 
documentation

Registration Register the software and remove the time 
limit

Order Online Place an online order and get the license

Support Or Bug Report Support or bug report

Home Page Go to the software homepage

Live Update Check for a new version

About Display program information, version number 
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Waveform Editing Interface

Waveform Editing Interface Menu consists of four parts:

●     Waveform display
●     Display Range Bar
●     Amplitude Ruler
●     Time Ruler

 Tip: See also Operations With Mouse and Scrolling Through a Waveform 

 

Waveform Display

Waveform Display is the area where you view your audio material. There are many mouse operations 

available in the Waveform Display for selecting data: 

Left-click anywhere in the waveform and you will change the position of the playback cursor. 

With stereo waveforms, position the mouse pointer at the top or bottom of the Waveform Display (the 

cursor will acquire L or R letter) and left-click to enable only the left or right channel for editing (the 

disabled channel will ray-out, another left-click on the disabled channel to re-enable it.

Left-click and drag in the waveform display to make a selection.

Double left-click in the waveform display to select the entire visible portion of the waveform (when 

zoomed in this does not select unseen areas which may be to the right or left). 
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Right-click to create, extend or shorten a selection. The selection will extend or shorten the currently 

selected range up to the specified point, or stem from the cursor position if there is no existing 

selection.

Display Range Bar

Green Display Range Bar on the top of the Waveform Display Window indicates which part of the 

entire waveform is currently being viewed in the Waveform Display. When zooming in or out, this bar 

will get smaller or larger, as the portion being viewed changes with respect to the entire waveform or 

session. 

Left-click and drag the Green portion of the bar to scroll forward or backward in time. As with 

dragging in the Time Ruler, the zoom level is retained, only the viewing range is altered.

Amplitude Ruler 

  

Amplitude Ruler measures the relative volume of audio data. In Waveform View, the ruler's display 

format can be set to either Samples (exact sample value of the data), Decibels or as a Normalized 

Value (-100 to 100).

Use right-click on the amplitude ruler to set the format and to show or hide Amplitude Ruler

Time Ruler
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Time Ruler shows the current location at any point in the waveform display. The time markings are 

subdivided into more detail when zoomed in, and less detail when zoomed out.

Use right-click on the Time Ruler to set the Time Ruler format (Decimal or Samples) and to show or 

hide Time Ruler.
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Operations With Mouse

The following operations with a mouse are possible

 Tip: See also Scrolling Through a Waveform and Waveform Editing Interface

Left click:

1.in the marker's area (cursor is the "tick"), near marker. Then select region are set in accordance 

with the marker. If the marker picks out any area then select region are set in accordance with 

the marker too. 

 

2.in the stereo channels area (cursor is the "L" or "R"). One of the stereo channels is picked out 

and all operations do not affect another channel. It does not work for the mono files. 

 

3.in the any waveform area. Current position is changed. 

Double click:

1.If cursor is situated near current marker position, the current marker position is added, 

otherwise - current cursor position is added like a marker position. 

2.Cursor points to the marker. Marker is deleted.

3.Double click the main editor window. The whole region selected. Page 70



Right click:

1.In the any waveform area. Current area is picked out. The nearest bound is moved to the 

current cursor position. 

2.In the stereo channels area (cursor is the "L" or "R"). One of stereo channels is picked out and 

all operations do not affect another channel. It does not work for the mono files. 

Move the mouse with left button clamped:

1.In the any waveform area. Current position is picked out. Near the border of early detailed area 

the type of cursor is changed and user can decrease or increase dimension of the current detailed 

area. 

2.In the stereo channels area (cursor is the "L" or "R"). One of stereo channels is picked out and 

all operations do not affect another channel. It does not work for the mono files.

3.In the Zoom area. The waveform rolls if  Zoom In operation is used before. 
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Scrolling Through a Waveform

Scrolling Through a Waveform

The green Display Range Bar 

 

 Tip: See also Operations With Mouse and Waveform Editing Interface

Above the waveform indicates which portion of the entire wave is being viewed at the moment. When 

zoomed in or out, this bar gets smaller or larger respectively, as the portion being viewed with respect 

to the entire wave is smaller or larger. You can click and drag the green bar at any time to scroll the 

portion being viewed left or right. You can also click and drag the Time Ruler to scroll through a 

waveform, move it to the extreme right or left. 
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Editing Individual Channels

Editing Individual Channels

At times, you may want to edit only one channel of a stereo file. Normally both channels are edited 

simultaneously (as in applying reverb to a waveform). You can, however, edit channels independently 

by disabling the left or the right side. To do so, simply click near the top (for the left channel) or 

bottom (for the right) of the waveform. When you do so, the mouse cursor acquires an L or an R 

letter respectively. When you see, for example, letter R in the right channel, click and the left channel 

will be disabled. To return to stereo editing click on the disabled channel. When pasting, the audio 

data is overlapped with what is already there, since inserting only in one channel will put the channels 

completely out of phase.
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The Selection Tool Dialog

This dialog allows you to select data by specifying starting and ending points or choosing a selection 

from a list of regions. To display the Set Selection dialog, choose Selection Tool from the View menu.

Select data: 

1.From the View menu, choose Selection Tool.

2.Choose a selection type from the Selection drop-down list, or choose Custom to specify a 

custom selection: 

   a. Type a value in the Start edit box to specify a starting point for your selection. 

   b. Type a value in the End edit box to specify an ending point for your selection. 

   Specifying a value in the End box will modify the value in the Length box. Specifying a value in 

the Length  

   box will modify the value in the End box. 

   c. Type a value in the Length edit box to specify the length of your selection. 

3.Click the OK button.
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Trim

  Adds trim effect to the selected part of an audio file.

Parameter Description

Trim Level Maximal amplitude in db, which is considered as silence, from -92 db to 0. 

Fade Time Time of trim fade, in ms. 

Trim Type The type of trim. Can be one of the following types: trim from left, right or 
from both sides of trim level. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. N db = 20 lg (Pn/P0) 
 
N - number of db. 

Pn - Level of sound pressure in pascals. 

P0 = 2*105 pascals.  
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Mix

Mix

  Mixes the selected part of an audio file with an object from the buffer.

Parameter Description

Amplify Select The amplification percent for the selected part of an audio file. Varies 
from 0 to 100. 

Amplify Paste The amplification percent for an audio array in the buffer. Varies from 0 
to 100. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. Before using Mix, you should copy data to the buffer.  
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Insert Silence

Insert Silence

  Inserts silence in an audio file.

Parameter Description

Length Duration of silence in milliseconds. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. If a part of a file is selected then the signal is inserted instead of the selected part, otherwise it 

is inserted to the current cursor position. 
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Channel Converter

  Mixes stereo channels in the selected part of an audio file.

Parameter Description

New left channel from left A percentage left channels time. Varies from 0 to 100. 

New left channel from right A percentage left and right channels time. Varies from 0 
to 100. 

New right channel from left A percentage right and left channels time. Varies from 0 
to 100. 

New right channel from right A percentage right channels time. Varies from 0 to 100. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter 
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Delete Silence

Delete Silence

  Deletes silence from the selected part of an audio file.

Parameter Description

Thres Hold Certain level for threshold, in db. Varies from -92 to 0. 

Attack Time Time for volume increase, in ms. Usually the value of Attack Time property is much less 
than Release Time. 

Release Time Time for volume decrease, in ms. Usually the value of Attack Time property is much less 
than Release Time. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. IN db = 20 lg (Pn/P0) 
 
N - number of db. 

Pn - Level of sound pressure in pascals. 

P0 = 2*105 pascals.

3. Following picture shows change of the volume for this method. 
 

 
 
If signal is below the Threshold for more than Attack Time, beginning of that spot in the audio will be considered 

beginning of silence.  
 
If signal is above the Threshold for more than Release Time, beginning of that spot in the audio will be considered Page 79



end of silence.  
 
Silence Definition  
 
For very quiet high quality audio, the Thres Hold value will be lower (like -60dB). For noisier audio, the value may 

be much higher (like -30dB).  
 
If audio is above this given threshold for more than the number of milliseconds given, audio will be considered 

valid, and not silence. Use higher values for Release Time to ignore short periods of audio (like clicks, static, or 

other noise). If this value is too high however (above 200ms), short words may be skipped.  
 
Use much less values for Attack Time than Release Time. 
 

Page 80



Audio Editor
Fade Custom

Fade Custom

  Creates a fading in (soft to loud) or fading out (loud to soft) effect in the selected part of an audio 

file.  

  The wave data will be linearly faded from the starting magnitude Start to the ending magnitude End.

Parameter Description

Start Starting value percent, varies from 0 to 100. 

End Ending value percent, varies from 0 to 100. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter 
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Amplify

  Applies Amplify effect to the selected part of an audio file. Changes amplitude of the input audio file.

Parameter Description

Rate 
An amplification coefficient in percent. If Rate = 100, then audio array isn't 
changed. If Rate > 100 then Volume of audio is increased, otherwise it is 
decreased. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. The method doesn't change amplitude at the first and last position of the audio array, if property 

Smooth Enabled is set to True. 
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Normalize

  Normalizes the selected part of an audio file.

Parameter Description

Trim Level 

Normalization coefficient. Varies from 0 to 100. The percentage of 
maximum to which you want to normalize. For example, choose 50% to 
compute values needed to amplify the selection no more than 50% of 
maximum. 

Fade Time Can be Selected (leveling) or Unselected (not leveling). 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. Amplifies the selection part to within the specified percentage of the maximum level.  
 
This function enables you to achieve the greatest amount of amplification that will not result in 

clipping. To normalize to less than the maximum range enter the percentage of maximum to which 

you want to normalize. For example, if you choose 50%, Audio Editor Gold will compute values 

needed to amplify the file no more than 50% of maximum. If two sounds that have been normalized 

to 50% are overlapped, the resulting wave will not exceed the boundaries, and will not clip. 
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Compressor

  Reduces the dynamic range of a signal.

Parameter Description

Thres Hold Certain level for threshold, in db. Varies from -92 to 0. 

Rate Rate of mixing signals, in percent. Varies from 1 (minimal effect) to 100 
(maximal effect). 

RMS Time Time for root-mean-square calculation, in ms. Usually RMS Time is equal to 
100 ms. 

 
   Tip: 

1.See also: Apply a Special Effect or Filter

2. N db = 20 lg (Pn/P0) 
 
N - number of db. 

Pn - Level of sound pressure in pascals. 

P0 = 2*105 pascals. 

3. A compressor is basically a variable gain device, where the amount of gain used depends on the 

level of the input. In this case, the gain will be reduced when the signal level is high which makes 

louder passages softer, reducing the dynamic range. This effect equals dynamic volume regulator.

4. This behavior is opposite to that of the Expander.  
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Stretch Time

  Stretches an selected part of an audio file by time.

Parameter Description

Rate The rate of the stretching. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. For example for the voice audio file the speech is increased or decreased without frequency 

changing. 
 
The Stretch function enables you to change frequency and duration of an audio signal. You can also 

change either frequency or duration without affecting the other. For example, you can use Stretch 

to transpose a song to a higher key without affecting the duration, or to slow a passage down 

without changing the frequency. Frequency and duration can also vary over the length of the audio, 

giving the effect of slowing down and speeding up, or raising and lowering frequency. 
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Vibrato

  Makes a Vibrato effect in the selected part of an audio file.

Parameter Description

Sweep Depth The depth of the vibrato effect, in percent. Varies from 0 (no effect) 
to 100 (maximal effect). 

Sweep Frequency The certain frequency of the vibrato effect, in hertz. 

Sweep Phase Phase of delay, in radian. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. Vibrato equals a cyclical changing of certain frequency of input signal. 
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PitchShift

  Lowers pitch, while the tempo or speed of play remains the same.

Parameter Description

Rate The shifting rate. Lower percentages (from 1 to 99) increase the pitch. 
Higher percentages (above 100) lower the pitch. The tempo is preserved. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. This effect shifts the frequency spectrum of the input signal. It can be used to disguise a person's 

voice, or make the voice sound like that of the "chipmunks", through to "Darth Vader". It is also 

used to create harmony in lead passages, although it is an "unintelligent" harmonizer.

3.The Pitch Shift method cannot accept negative values at all. 
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Delay

Delay

  Makes a Delay effect in a selected part of an audio file.

Parameter Description

Duration Maximal amplitude in db, which is considered as silence, from -92 db to 
0. 

Mix Depth Time of trim fade, in ms. 

Feed Back Gain The type of trim. Can be one of the following types: trim from left, right 
or from both sides of trim level. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. Delay is an echo effect that replays what you have played one or more times after a period of 

time. It's something like the echoes you might hear shouting against a wall. 

You can use this function to create single echoes, as well as a number of other effects. Delays of 35 

milliseconds (ms) or more will be perceived as discrete echoes, while those falling within the 35-15 

ms range can be used to create a simple chorus or flanging effect. (These effects will not be as 

effective as the actual chorus or flanging effects, as the delay settings will be fixed and will not 

change over time). 
 

3. For more information about delay effect see: http://www.audioeditor.us 
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Phaser

Phaser

  Applies phasing effect to the selected part of an audio file.

Parameter Description

Duration Delay time, in milliseconds. 

Mix Depth

The dry is the volume of the input signal and the wet is the volume of 
the delayed signal, in percent. Varies from 0 to 100. If Mix Depth = 0 
result signal isn't contain delayed signal. If Mix Depth = 100 result 
signal isn't contain input signal. Other values of Mix Depth are 
combination of the dry and the wet (wet = 100 - dry). 

Feed Back Gain Feed Back Gain sets how much delay is feed back to the input. Varies 
from 0 to 100. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. The phaser achieves its distinctive sound by creating one or more notches in the frequency 

domain that eliminate sounds at the notch frequencies.

3. For more information about phaser effect see: http://www.audioeditor.us 
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Flanger

Flanger

  Applies Flanging effect to the selected part of an audio file.

Parameter Description

Delay Rate Rate of delay. Varies from 0 (there isn't delay) to 100 (delay is 20 ms). 

Mix Depth

The dry is the volume of the input signal and the wet is the volume of 
the delayed signal, in percent. Varies from 0 to 100. If Mix Depth = 0 
result signal isn't contain delayed signal. If Mix Depth = 100 result 
signal isn't contain input signal. Other values of Mix Depth are 
combination of the dry and the wet (wet = 100 - dry). 

Feed Back Gain Feed Back Gain sets how much delay is feed back to the input. Varies 
from 0 to 100. 

Sweep Depth The sweep depth determines how wide the sweep is in terms of delay 
time, in percent. Varies from 0 (no effect) to 100 (maximal effect). 

Sweep Rate
This parameter refers to the frequency of flanging. Varies from 0 to 
100, in percent.

Sweep Phase Phase of delay, in radian. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. Flanging is created by mixing a signal with a slightly delayed copy of itself, where the length of 

the delay is constantly changing. It is actually one specific type of phasing (Phaser).

3. For more information about flanging effect see: http://www.audioeditor.us 
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Reverb

Reverb

  Reverberates selected part of an audio file.

Parameter Description

Duration The delay time, in ms. 

Mix Depth 

The dry is the volume of the input signal and the wet is the volume 
of the delayed signal, in percent. Varies from 0 to 100. If Mix Depth 
= 0 result signal isn't contain delayed signal. If Mix Depth = 100 
result signal isn't contain input signal. Other values of Mix Depth are 
combination of the dry and the wet (wet = 100 - dry). 

Feed Back Gain The feedback sets how much delay is feed back to the input. Varies 
from 0 to 100. 

Reverb Gain The level of reverberation signal in db. 

Tap Delay The number of taps before delay is fed back to the input. 

Reverb Frequency The type of trim. Can be one of the following types: trim from left, 
right or from both sides of trim level. 

 
   Tip: 

1.See also: Apply a Special Effect or Filter

2.It is the sound you hear in a room with hard surfaces where sound bounces around the room for a 

while after the initial sound stops.

3.For more information about flanging effect see: http://www.audioeditor.us 
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Chorus

Chorus

  Applies chorus effect to the selected part of an audio file.

Parameter Description

Delay Rate Rate of delay. Varies from 0 (there isn't delay) to 100 (delay is 20 ms). 

Mix Depth 

The dry is the volume of the input signal and the wet is the volume of 
the delayed signal, in percent. Varies from 0 to 100. If Mix Depth = 0 
result signal isn't contain delayed signal. If Mix Depth = 100 result 
signal isn't contain input signal. Other values of Mix Depth are 
combination of the dry and the wet (wet = 100 - dry). 

Feed Back Gain Feed Back Gain sets how much delay is feed back to the input. Varies 
from 0 to 100. 

Sweep Depth The sweep depth determines how wide the sweep is in terms of delay 
time, in percent. Varies from 0 (no effect) to 100 (maximal effect). 

Sweep Rate
This parameter refers to the frequency of flanging. Varies from 0 to 
100, in percent.

Sweep Phase Phase of delay, in radian. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. The Chorus differs from the Flanger in only a couple of ways. One difference is the amount of 

delay that is used. The delay times in a Chorus are larger than in a Flanger, usually somewhere 

between 20 ms. and 30 ms. (the Flanger's delay usually ranges from 1 ms. to 10 ms.) This longer 

delay doesn't produce the characteristic sweeping sound of the Flanger. The Chorus also differs 

from the Flanger in that there is generally no feedback used.

3. For more information about chorus effect see: http://www.audioeditor.us  
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Expander

  Adds expander effect to the audio data array. The expander is essentially an amplifier with a variable 

gain control.

Parameter Description

Thres Hold Certain level for threshold, in db. Varies from -92 to 0. 

Rate Rate of mixing signals, in percent. Varies from 1 (minimal effect) to 100 
(maximal effect). 

RMS Time Time for root-mean-square calculation, in ms. Usually RMS Time is equal to 
100 ms. 

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. N db = 20 lg (Pn/P0) 
 
N - number of db. 

Pn - Level of sound pressure in pascals. 

P0 = 2*105 pascals.

3. The expander is a type of dynamic processor. As the name implies, it increases the dynamic 

range of a signal such that low level signals are attenuated while the louder portions are neither 

attenuated or amplified. 

●     This behavior is opposite to that of the Compressor.  
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Add Noise

  Inserts a noise in an audio file.

Parameter Description

Amplitude
An amplitude of noise in db, from -92 db to 0.

Noise Type
The noise type. 1- white noise, 2 - Gaussian noise.

 
   Tip: 

1. See also: Apply a Special Effect or Filter

2. If a part of a file is selected then the signal is inserted instead the selected part, otherwise it is 

inserted to the current cursor position. 
 
The Amplitude = -92 is equal to least noise signal, Amplitude = 0 is equal to most noise signal. 
 
N db = 20 lg (Pn/P0) 
 
N - number of db. 

Pn - Level of sound pressure in pascals. 

P0 = 2*105 pascals.  
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Invert

Invert

With the help of this function you can simply invert the samples, so that all positive offsets are 

negative and all negative offsets are positive. Inverting does not produce an audible effect, but it can 

be useful in lining up amplitude curves when creating loops, or pasting. On stereo waveforms, both 

channels are inverted. 
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Notch Filter

Notch Filter

Applies Notch Filter to the selected part of an audio file. 

Parameter Description

Frequency The central frequency of the filter, in Hertz.

Steepness Steepness of the filter, varies from 0.01 to 100.

 Tip: 
See also: Apply a Special Effect or Filter
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Peak EQ Filter

Peak EQ Filter

Applies Peak EQ filter to the selected part of an audio file. 

Parameter Description

Frequency The central frequency of the filter, in Hertz.

Steepness Steepness of the filter, varies from 0.01 to 100.

db Gain Gain in db. Varies from -92 to 0.

 Tip: 
1. See also: Apply a Special Effect or Filter

2. The Peak EQ filter decreases volume of the peaks. 
 
Regarding to the Nyquist Sampling Theorem the sample rate have to be at least two times higher 

than the highest frequency of analog audio signal. 
 
For example, the human ear can detect sound across the frequency range of 20 Hz to 20 kHz. 

According to the sampling theorem, one should sample sound signals at least at 40 kHz in order 

for the reconstructed sound signal to be acceptable to the human ear. 
 
So applying the low-pass analog filter to a file with sample rate of 8kHz you should take into 

consideration that the frequency parameter of this method have to be at least two times less ( < 

4 kHz) than the file's sample rate. 
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Band Pass

Band Pass

Applies Band Pass filter to the selected part of an audio file. 

Parameter Description

Frequency The central frequency of the filter, in Hertz.

Steepness Steepness of the filter, varies from 0.01 to 100.

 Tip: 
1. See also: Apply a Special Effect or Filter

2. The Band Pass filter consists in a Low Pass and a High Pass combined together, so it allows the 

frequencies falling within a certain range. The Band Pass filter will act like a Low Pass and a High 

Pass together: it will pass only the frequencies falling within a certain range. 

Page 98



Audio Editor
High Pass

High Pass

Applies High Pass filter to the selected part of an audio file. 

Parameter Description

Frequency The central frequency of the filter, in Hertz.

Steepness Steepness of the filter, varies from 0.01 to 100.

 Tip: 
See also: Apply a Special Effect or Filter
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Low Pass

Low Pass

Applies Low Pass filter to the selected part of an audio file. 

Parameter Description

Frequency The central frequency of the filter, in Hertz.

Steepness Steepness of the filter, varies from 0.01 to 100.

 Tip: 
See also: Apply a Special Effect or Filter
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High Shelf

High Shelf

Applies High Shelf filter to the selected part of an audio file. 

Parameter Description

Frequency The central frequency of the filter, in Hertz.

Steepness Steepness of the filter, varies from 0.01 to 100.

db Gain Gain in db. Varies from -92 to 0.

 Tip: 
See also: Apply a Special Effect or Filter
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Low Shelf

Low Shelf

Applies low Shelf filter to the selected part of an audio file. 

Parameter
Description

Frequency The central frequency of the filter, in Hertz.

Steepness Steepness of the filter, varies from 0.01 to 100.

db Gain Gain in db. Varies from -92 to 0.

 Tip: 
See also: Apply a Special Effect or Filter

Page 102



Audio Editor
Audio file formats

Audio file formats

Audio Converter support the following audio codecs: 
 

Codec Description

ADPCM
Compressed WAV format. ADPCM (Adaptive Differential Pulse Code Modulation) is an audio compression scheme which 

compresses from 16-bit to 4-bit for a 4:1 compression ratio.

ALAW

Compressed WAV format. A-Law (or CCITT standard G.711) is an audio compression scheme common in telephony 

applications. It is a slight variation of the u-Law compression format, and is found in European systems. This encoding 

format compresses original 16-bit audio down to 8 bits (for a 2:1 compression ratio) with a dynamic range of about 13-

bits. Thus, a-law encoded waveforms have a higher s/n ratio than 8-bit PCM, but at the price of a bit more distortion than 

the original 16-bit audio. The quality is higher than you would get with 4-bit ADPCM formats. Encoding and decoding is 

rather fast and generally, widely supported.

DSP Compressed WAV format. DSP Group True Speech (TM) format.

GSM Compressed WAV format. Good for keeping human speech.

G.726 Used for computer telephony. Good for keeping human speech.

MP3 MPEG Layer-3 format. Very popular format for keeping music.

PCM
Standard Windows WAV format for non-compressed audio files. Pulse Code Modulation (PCM) is the standard method of 

digitally encoding audio. It is the basic uncompressed data format used in file types such as Windows .wav.

ULAW

Compressed WAV format. u-Law (or CCITT standard G.711) is an audio compression scheme and international standard in 

telephony applications. u-Law is very similar to A-Law, a variation of u-Law found in European systems. This encoding 

format compresses original 16-bit audio down to 8 bits (for a 2:1 compression ratio) with a dynamic range of about 13-

bits. Thus, u-Law encoded waveforms have a higher s/n ratio than 8-bit PCM, but at the price of a bit more distortion than 

the original 16-bit audio. The quality is higher than you would get with 4-bit ADPCM formats. Encoding and decoding is 

rather fast and generally, widely supported.

VOX

Dialogic ADPCM format. The Dialogic ADPCM format is commonly found in telephony applications, and has been optimized 

for low sample rate voice. It will only save mono 16-bit audio, and like other ADPCM formats, it compresses to 4-bits/

sample (for a 4:1 ratio). This format has no header, so any file format with the extension .VOX will be assumed to be in 

this format.

RAW Raw format of audio files. Doesn't contain header of an audio file.

WMA
Windows Media Audio format. A special type of advanced streaming format file for use with audio content encoded with the 

Windows Media Audio codec. The .wma extension indicates a file format and how the content is encoded.

CCIT U-Law Compressed WAV format.

Ogg Vorbis Ogg Vorbis format.
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WMA format

WMA format

WMA stands for Windows Media Audio. WMA files contain perceptually encoded sound data.  
 
The frequencies that humans cannot perceive are removed, although some audio purists say they can 

tell the difference between a high bit-rate WMA and a Wave file.  
 
A WMA file can be as much as 20 times smaller than an equivalent WAV file.  
 
.WMA 
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Apply a Special Effect or Filter

Fade Custom" - For example:  

1. Open an audio file; 

2. Drag your mouse with left button down along the waveform until the point where you desire to 

select a session of the file; 

    See Also: Operations With Mouse 

 
3. Click Operation -> Fade Custom (or other effects and filters); 

4. Adjust the parameters, and then click the Ok button. 
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Recording with Audio Editor

Recording with Audio Editor

 Tip: You might be able to convert your sound card to a DirectSound-compatible full-duplex sound 
card by installing the latest version of the sound driver for your sound card. Contact the manufacturer 

of your sound card to inquire about how to obtain and install the latest version of the sound driver for 

your sound card. 

Recording from a Microphone 
 
Most sound cards can receive sound input from a microphone through the sound card microphone 

port. This is useful for recording voice or sounds directly to your computer. 
 

1. Check your hardware. If your microphone has never worked, or it stopped working, first check the 

physical connection of the microphone. Verify that it is firmly plugged into the microphone port 

instead of the headphone or speaker port.  

 Tip: If you are not sure which port is correct, you can check the sound card to see if it is 
marked. Sometimes the sound card has a picture of a microphone. Otherwise, you can use a 

process of elimination, check the documentation that came with your hardware, or contact the 

hardware manufacturer.  

2. Open Audio Editor. 

3. Choose "Options" > "Input Device" On the main menu. Click Mic, or Microphone. 

4. Adjust the recording volume for the highest possible performance. To do this, adjust the slider bars. 

5. Click the Record button and then speak into the microphone.  

6. If the microphone is plugged into the correct jack, the wave patterns on the display should move 

up and down. If it does not move, sound is not going to your microphone. If the wave moves, click 

the Stop button, and then click the Play button to listen to your recording. 

7. If the microphone is plugged into the correct jack, the wave patterns on the display should move 

up and down. If it does not move, sound is not going to your microphone. If the wave moves, click 

the Stop button, and then click the Play button to listen to your recording.

Recording from Videotape 
 
You can extract the audio from a videotape and then convert it to MP3 or WAV files.  

1. Connect the left and right audio-out terminals on the VCR to the line-in or microphone terminal on 

the sound card.  

2. Open Audio Editor. 

3. Choose "Options" > "Input Device" On the main menu. Click Mic, or Microphone. 

4. Adjust the recording volume for the highest possible performance. To do this, adjust the slider bars. 

5. Click Play on the VCR.   
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6. Click the Record button. You should see a wave pattern display of the audio as it is playing.  

7. If you are satisfied with the recording effect, then stop the recording test by clicking Stop button.  

8. Rewind the tape and start the playback from the point you want to record.  

9. In Audio Editor Gold, click the Record button and stand by.  

10. When you want to stop recording, click the Stop button.  

11. Click File > Save or Save As. This saves the videotape data as an MP3 or WAV file. 

Using a Sound Card Mixer for Windows  
 
If you cannot locate your sound card as an input device in Audio Editor , you can use the Windows 

Volume Control instead.  
 

1. In the Taskbar tray, in the lower right corner of the computer screen, double-click the speaker icon. 

The Volume Control dialog box appears.  
 

 Tip: If you do not have a speaker icon in your taskbar tray, you can display the Recording 
Control directly.  

          To display it in Windows 98 or ME, click Start > Settings > Control Panel. You can then click 

Sounds and Multimedia. On the Audio tab of the Sounds and Multimedia dialog box, click the 

Volume button in  

          the Sound Playback group. 

          In Windows XP, click Start > Control Panel. Click the Sounds and Audio icon. On the Audio 

tab of the Sounds and Audio Devices Properties dialog box, click Volume.

2. You can control which sound card speaker-input controls appear in the Volume Control window. In 

the Volume Control window, click Options > Properties. 

3. Select the controls that you want to appear.  

4. For each speaker-input shown, you can see a Volume slider and Mute checkbox, and perhaps other 

controls for balance, and so forth. The Volume slider controls the loudness for that particular speaker 

input and Mute turns it off completely.  

 Important: The Volume Control dialog box only sets options for speaker output and does not 
control recording. Do not clear the checkbox for the Microphone Mute control and turn up the 

microphone volume. If you do this, the Audio Editor cannot record from the microphone. 

5. Click Options > Properties again.  

6. Select Recording and select all the controls. The Volume Control dialog box is replaced by Record 

Control.  

7. For each recording input, you can click a Select checkbox and adjust Volume slider. Do one of the 

following: 

    a. If you want to record from the microphone, check the Microphone Select checkbox. 

    b. If you want to record from Line-In, select the Line-In Select checkbox.  

8. If the recording volume is too low, turn up the appropriate Volume slider.  
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 Tip: Sometimes you might wish to record streaming audio. Many modern sound cards present 
a recording input called Wave (Stereo mixer) that may work. Several sound cards also offer a 

recording input called What U Hear or a similar name, that records anything that can be heard over 

the computer speakers. 
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Save a Session of an Audio File

1. Open an audio file; 
 
2. Drag your mouse with left button down along the waveform until the point where you desire to 

select a session of the file; 
 
3. Click File->Save selection as... to save the selection in a desired directory. You can set the output 

file format and you can also change the output audio file's sample rate, channel and bit rate 

information by click Options -> Output Format Settings.
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Merge Two or More Selections Together

1. Open an audio file; 
 
2. Drag your mouse with left button down along the waveform until the point where you desire to 

select a session of the file; 
 
3. Click Edit->Copy to copy the selection to the clipboard; 
 
4. Open another audio file; 
 
5. Move the mouse to the point where you want to paste the selection to and left click it; 
 
6. Click Edit->Paste to paste the previous selection into the second file. Now two audio files are in the 

same file, you can then edit them as you like, and save them as one file.
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Mix Audio Data

To mix any audio data from the files with the current wave open Edit/Mix from file menu.  

To mix any audio data from the clipboard with the current wave open Edit/Mix menu.

Clipboard data is overlapped starting at the current insertion point or selection. If the format of the 

waveform data on the clipboard differs from the format of the file it is being pasted into, Audio 

Editor Gold converts it before pasting.

Page 111



Audio Editor
Modify Settings

Modify Settings

Customize Audio Editor Gold Temporary folder, Play/Record buffer, Undo/Redo level, transform 

smooth, and smooth time in Options -> Properties menu.

1. Temporary folder 

The Temporary folder is the path to store temporary file created by Audio Editor. Audio Editor 

creates temporary files on a HDD after applying all edits. The files' name is NCT*.tmp, for example 

NCT7A.tmp. Each file name generates randomly. The files are in the Uncompressed PCM format 

(WAV). You can change the extension to .wav and play it with any audio player.

The first temporary file is created only after the New or Open methods.

2. Play/Record buffer 

It is the buffer for the following operations with an audio file: Copy, Cut, Paste, Mix. The computers 

of modern release can work with the maximum value of File Buffer Size, but old releases usually 

require a lesser value.

3. Undo/Redo level 

Audio Editor creates temporary files on a HDD after applying each transform  method from. It 

always takes some time to save a temporary file. Time depends on the size of the current file. So 

some large files may cause low memory conditions that could slow down the system. To speed it up 

you can set Undo/Redo level property to 1, but in this case it will be possible to reverse or restore 

only the last action.

4. Transform smooth enabled/Transform smooth time

Any supported effect has sudden change on the bound. The Smooth enabled property enables 

smoothing on this bound and bound neighborhood. You can also set Transform smooth time. 

Default smooth time is set to be 50ms. 
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Introduction

The CD Burner is an easy-to-use program, without bells and whistles, specially designed to burn CD.

With the CD Burner you can digitize a sound and save it to the hard disk, in a way that is suitable to 

burn it on an audio CD.

See also:

●     How to proceed
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CD Burner
How to proceed

How to proceed

 

• Add Files : Click Add button to add the files to your project list you want to burn on CD. A browser 

dialog will open in which you can browse for the files you want to add to the list. 
 
• Delete File : Remove files using the delete button. 
 
• Clear: Use the Clear buttons to delete all the selected files.  
 
• Question Icon: Displays information about the software.  
 
• Device: Select the device in the drop list. 
 
• Write Speed: Select the write speed in the drop list. 
 
• Write Disc: Press this button to burn.  
 
• Cancel: Press this button to stop burning.  
 
• Burning Progress : See details of burning status. 
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Introduction

Introduction

The MP3 CD Burner is an easy-to-use program, without bells and whistles, specially designed to 

burn MP3 to CD.

With the MP3 CD Burner you can digitize MP3 to the hard disk, in a way that is suitable to burn it on 

an audio CD.

See also:

●     How to proceed
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MP3 CD Burner
How to proceed

How to proceed

 

• Move Down Icon : Select operation of burning process in the pop up dialog. 
 
• Add File : Click on the Add button to add the MP3 files to your project list you want to burn on CD. 

A browser dialog will open in which you can browse for the files you want to add to the list. 
 
• Delete File : Remove files using the delete button. 
 
• Delete folder: Delete the added folder using this button. 
 
• Clear: Use the Clear buttons to delete all the selected files. 
 
• Question Mark: Displays information about the software.  
 
• Device: Select the device in the drop list. 
 
• Write Speed: Select the write speed in the drop list. 
 
• Write Disc: Press this button to burn now!  
 
• Cancel: Press this button to stop burning.  
 
• Check box : Click a check box to apply related actions. Page 116
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Introduction

CD Grabber is a convenient, fast, and powerful program for digitally extracting audio from CD-ROMs, 

written for 32-bit Windows platforms (95/98/2000/NT). If the CD-ROM unit on your computer 

supports Digital Audio Extraction and has an ASPI manager installed, CD Grabber can directly read 

the audio from your music CD-ROMs and store it on your hard drive in either WAV, MP3 or Ogg Vorbis 

format. Under Windows NT and 2000, it can even work without an ASPI manager via the SCSI pass-

through interface. For MP3 encoding, the Blade Encoder DLL and LAME Encoder DLLs are both 

supported. It works on most all ATAPI (IDE) CD-ROMs, and on some SCSI and CD-R/RW devices. 
 

 
Refresh CD: Rescans the TOC of the currently loaded CD. 
 
ID3 Settings: Edit ID3 tag information.  
 
Rip Tracks: Begins ripping all tracks marked with a check mark. 
 
Settings: Brings up the options dialog. 
 
Artist: Edit the Artist's name. Included in the ID3 tag. 
 
Album: Edit the Album title. Included in the ID3 tag.  
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Quick Start

The following instructions should get you ripping tracks in no time! 
 
1. Start the program. The default location is Start->CD Grabber. 
 
2. Select a CD unit by pressing the Options button to bring up the CD options dialog. Place a CD into 

the CD drive on your computer and hit the "Refresh" button. You can cause CD Grabber to 

automatically scan the TOC on startup by clicking on the Options Button on the toolbar and checking 

the Auto scan TOC checkbox.

 

 
3. Check your output directory and format. During the installation procedure, an "output" directory 

will be formed in the directory where you installed CD Grabber. If you don't want to use this default, 

change it by clicking on the Options->Output Options menu item. This is also where you select the 

output encoder to use (Raw audio, WAV, Lame_enc, Vorb_Enc).
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4. Check the track(s) you want to rip. To select all tracks, click on the Select All item. To 

automatically check all tracks, check the "Auto check track" checkbox in the Options. 
 
5. Check the MP3 Options to encode to MP3 files.
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6. To edit the names of the tracks, either left click on the track name, and click on the Rename item 

(right-click on the track name) and select Rename from the popup menu. 
 
7. If you have enabled ID3 tags in the MP3 options, you'll need to set the ID3 info for the CD. Click on 

the ID3 button to do this.
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9. Click the button to begin extracting all checked tracks. 
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CD Options Dialog

 
Drive: Selects the CD-rom unit to use. 
 
Read Algorithm: Selects the read algorithm used by the program. Most users will want to leave this 

on Autodetect. If you are unable to rip tracks using autodetect, or if the sound is garbled, experiment 

and try the other settings for the read algorithm.  
 
Autoscan TOC: When checked, the program will automatically scan the CD in the default drive when 

the program is started.  
 
Autocheck tracks: When checked, the program will automatically check all tracks after an automatic 

scan of the TOC or after pressing the "Refresh" button.  
 
Jitter Correction: When set to "Always", the program will always attempt to align the output file by 

using overlapped reads. For "On Error", it will attempt jitter correction only after an error is reported 

by the CD. "Never" disables jitter correction. "On Error" gives almost as good results as "Always", and 

is much faster, since the drive has to seek after every read when in "Always" mode.  
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Read Tracks: Maximum number of frames that will be read at once. Some drives can handle larger 

values, but some can't handle more than 27.  
 
Jitter Check: When using overlapped reads (for Jitter correction modes "always" and "on error"), this 

is the number of frames that the program will attempt to match.  
 
Overlap: When performing jitter correction, this is the number of frames that will be overlapped. 

Overlap must be at least two greater than the value used for Jitter Check.  
 
Reset: Resets the Jitter Correction configuration to default values. 
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Output Options Dialog

Output Options Dialog

 
Output Folder: The folder where output files will be saved.  
 
Browse: Click the Browse button to select the directory that output files will be saved in.  
 
Encoder: Select the encoder and output format to use from the drop down list. Currently supported 

encoders are Lame_Enc.dll, BladeEnc.dll, and Vorb_Enc.dll. You may also select output to WAV files 

and raw data.  
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MP3 Options Dialog

General Options:  
 
Bit rate: Selects the constant bit rate for the MP3 file in kbit/sec. Note: when using VBR(Variable Bit 

Rate) under LAME_ENC, this represents the minimum bit rate. 
 
Enable ID3 Tags: When checked, an ID3v1 tag will be added to the MP3 file. If no ID3 information 

was input for the current CD in the drive, no tag will be written, even if the item is checked. 
 
Generate CRC: When checked, a CRC will be generated for each MP3 frame. 
 
Original: Sets the "Original" flag in the MP3 file. 
 
Copyright: Sets the Copyright flag in the MP3 file. 
 
Private: Sets the Private flag in the MP3 file.  
 
 
Lame Encoder Options:  
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VBR Quality: A value from 0 to 9. While 0 represents the highest quality, it increases the overall 

encoding time. According to the LAME documentation, for the highest quality files, values for VBR 

Quality should be 4 or less. 
 
VBR Max. Bit rate: The maximum bit rate used when VBR is enabled. 
 
MPEG Quality: The overall quality of the MP3 file: Normal, Low, High, Voice. 
 
Enable VBR: When checked, the VBR (Variable Bit Rate) option is enabled. 
 
Write VBR Header: Causes the VBR header to be written to the MP3 file. When using VBR, this 

header will allow MP3 players to determine the proper length of the file.  
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Vorbis Options Dialog

Ogg Vorbis is a new, open-source audio codec similar in quality and compression to MP3. However, 

unlike MP3 it is not encumbered by patent issues. This means that it can be included in a freeware 

product without having to obtain a costly license. Also, unlike MP3, it is inherently VBR, so the 

encoder only uses the amount of bits it needs, resulting in smaller files of the same quality. Vorb_enc.

dll, which is included in this distribution, is based on the libraries from xiph.org.

 
VBR Bit rate: The bit rate with which to encode. Vorbis is inherently VBR (variable bit rate), and the 

bit rate that you select will be an ideal average. 
 
Version: Used to designate multiple versions of same track. Stored in the Vorbis comment header. 
 
Description: Short description of track's contents. 
 
Genre: The overall genre (if any) that the music belongs to. 
 
Date: Date the track was recorded. 
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Location: Where the track was recorded. 
 
Copyright: Copyright info for the track.  
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Freedb Options

CD Grabber is capable of querying the Freedb database and other databases based on the original 

protocol on the Internet to automatically fill in the artist name, album title and the titles of all of the 

songs. To use this feature, make sure that "Enable Freedb" is checked on the Tools menu.

 
Server: Address of the Freedb server to use. 
 
CGI Script: This should contain the relative address of the CGI used for submitting queries on the 

server. 
 
Get List: Gets the available server list from the currently configured server. Note: If you change the 

Freedb server, you must click on "Apply" before you can use the "Get List" button. 
 
Reset List: Resets the list of available servers to "freedb.freedb.org". Do not reset the configured 

server. 
 
Use Proxy: If you are located behind a firewall and need to connect through an HTTP proxy, check 

this box. Page 129
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Proxy Server: Address of the proxy server. Contact your system administrator for this information. 
 
Proxy Port: Port on which to contact the proxy server. Contact your system administrator for this 

information.  
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Misc Options Dialog

M3U Playlist

Enabled: When checked, an M3U playlist file (used by WinAmp) will be generated containing all of 

the tracks extracted. 
 
Use Album Name As Filename: When selected, the M3U file will use the album name as it's 

filename, with the .M3U extension, in the same directory as the files being extracted. 
 
Specify Filename: Specify the file to use for M3U files.  
 
 
Filename Macros  
 
Specify how the output files will be named. The mechanism works thusly:  

1.If a macro is entered in the provided edit box, it will be used. "$T" will be replaced with the track 

number, "$N" with the track name, "$A" with the artist, and "$L" with the album title. Note: if an item 

is not supplied, it will be simply be skipped, so you must ensure that all items are supplied.  

2.If no macro is supplied, but the file has been renamed (by or manually), that name will be used  
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3.Otherwise the track will be named "Track x.ext", where x is the track number and .ext is the 

extension for the configured output format.  
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ID3 Tags

ID3 Tags

ID3 tagging is a method of including information about the artist's name, album title, song title, year 

and genre directly in an MP3 file. Currently, only ID3v1 is supported, since most MP3 players support 

it. ID3v2 is still under development and will be enabled in future releases after the format is finalized. 

For more information on ID3, you can visit www.id3.org. The "ID3 Info" dialog is available either by 

pressing the ID3 button on the toolbar, or by selecting the "Options->Edit ID3 Tag" menu item.

Artist: Enter the name of the artist here. 
 
Album: Enter the name of the album here. 
 
Year: The year in which the track was recorded. 
 
Genre: The genre that the track best fits into. 
 
Enable ID3 Tags: When checked, an ID3 tag will be generated for MP3 files. If the artist or album 

name are not filled in, no MP3 tag will be generated, regardless of the state of this checkbox.  
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Rip Segment Dialog

If you need to rip just a portion of one or more track, or to combine one or more tracks, click on "Rip 

Segment" to bring up the Rip Segment dialog.

The top slider represents the start frame for the segment to rip, and the bottom slider represents the 

end frame. You can "snap" the sliders to the beginning of the current or next track by clicking directly 

to the left or to the right of the slider. You can manually enter the start/end frames -- the length of 

the currently selected segment is shown in (minute:second:frame) format. A frame is 1/75 of a 

second. It also indicates where the selected segment starts and ends relative to the start of tracks. In 

the example above, it is set to rip tracks 2 and 3 as one contiguous segment -- the overall length of 

the segment is 42923 frames, or 9 minutes, 32 seconds and 23 frames (or about 0.31 sec.). 
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Frequently Asked Questions

Q: What's an ASPI manager, and how do I know if I have one? 

A: ASPI is an interface created by Adaptec, and is used by CD Grabber to access the CD-ROM 

hardware. Windows 95 comes with the ASPI manager pre-installed, while NT does not. To tell if you 

have an ASPI manager installed, look for a file called WNASPI32.DLL in your Windows system 

directory (c:\windows\system or c:\winnt\system32 are common locations). For NT, it is usually 

supplied by the manufacturer of your SCSI adapter or devices -- unfortunately, not usually supplied 

for IDE devices under NT. Some ATAPI CD-R and CD-RW devices do however supply the ASPI 

manager, specifically so that it can interface with the CD-R and CD-RW burning software. 
 
 
Q: Does CD Grabber work without an ASPI manager? 

A: Under Windows NT (SP 4+) and Windows 2000, CD Grabber can use the SCSI pass through 

interface to gain low-level access to the CD unit. The preferred method is still via the ASPI manager, 

but since neither Windows 2000 nor NT has a built-in ASPI manager, this method is provided as a fall-

back. 
 
 
Q: What is "jitter", and just how does "jitter correction" work? 

A: "Jitter" is a term used for the inherent uncertainly in most CD-rom units, which is caused by the 

way audio is stored on a CD. Although one logical block on a CD takes up 2352 bytes, the amount of 

data stored in the block varies. For a data block, 2052 bytes are actual data, and the remaining 300 

bytes are information used to accurately find the block. For audio, however, all 2352 bytes contain 

audio data -- there is no positioning information returned in the block read. When CDs first came out, 

they were used for audio, and it didn't matter if a CD player got within +/- 1/75 of a second of the 

intended start position. After it started, as long as the player kept reading, it could accurately read 

the data -- the problem only came about when initially seeking the start position. 
 
"Jitter correction" is the process of trying to compensate for "jitter" in software. Generally, it involves 

using overlapping reads, and attempting to match the end of one read with the beginning of the next, 

so that there are no gaps in the data read. These gaps cause clicks and pops in the resulting WAV or 

MP3 file produced. For instance, the program might begin reading a track at block 1000 and read 27 

blocks total. On the next read, it would issue a read command starting at 1024, and would try to 

match the end of the first read in the beginning of the second read. Once it finds a match, it would cut 

off the beginning of the second read, and use only the part after the match. In this way, you can 

eliminate the clicks and pops. 
 
CD Grabber has an additional, more sophisticated mode for jitter correction. It will attempt to issue 

many read commands quickly and buffer the output. When ripping with CD Grabber, you can see this 

happening in the "Read buffer" gauge on the rip dialog -- it will attempt to buffer as much as it can 

quickly, and then wait for the encoder to process it. When the buffer is almost empty, it starts reading 

again. It only performs jitter correction after an error is reported by the CD unit. Most drives will read 

audio correctly as long as the drive doesn't stop reading for too long, and read commands are issued Page 135
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sequentially, i.e. the next read starts immediately where the last read left off. Using this method 

results in a vast speed improvement over brute-force jitter correction. 
 
Most times, an LP or music cassette also contains multiple separated tracks, so that you can easily 

digitize each track one by one, or you can use the Audio Editor to separate tracks if you record an 

entire LP or cassette side at once. 
 
 
Q: I can't seem to rip any tracks at all. Help! 

A: Try resetting the jitter correction values to their defaults in the CD Options dialog (click on the 

"Reset" button). If that doesn't work, In the CD Options dialog, try using the "Auto detect" read 

algorithm. If it still doesn't work, try the others individually. If none of this helps, send an email to 

support@audioeditor.us with the make and model of your CD rom, operating system (Win95/98/

NT,2000), whether it's a SCSI, ATAPI, CD-R, etc. and a description of the problem. It's also possible 

that your drive simply doesn't support digital audio extraction -- while most SCSI drives support 

digital audio extraction, not all IDE drives do. 
 
 
Q: I can rip, but it seems to rip very slowly. 

A: Try checking the "On Error" jitter correction in the "CD Options" page. This mode is faster than the 

"Always" setting, and should produce results comparable to "Always". 
 
 
Q: How can I tell if my CD supports digital audio extraction? 

A: If CD Grabber doesn't seem to work with your CD, try a different program -- you can find many 

shareware and freeware programs at http://www.audioeditor.us. 
 
 
Q: I'm still getting clicks and pops in the ripped tracks. What can I do? 

A: Go to the CD Options page by selecting the Options->CD Settings menu item. Try using the 

"Always" setting for jitter correction -- this setting will attempt to correct inaccuracies in the 

positioning of the read regardless of whether the CD reported an error or not. If you receive errors, 

try increasing the overlap a little; this will increase the size of the buffer that is used to align the read, 

and so increases the chances for successful alignment. 
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Appendix

An important stage of mp3 authoring is specifying the MP3 setting. This involves multiplexing the 

project’s channel, encoding selecting, VBR and etc into MP3-compliant form. This section describes 

the various output options in MP3 setting.  
 
The following table documents contain options for specifying Channel Mode and Encode Quality. 

These options should be configured according to personal preference or hardware requirement. 
 
Channel 

Channel Description

Mono

In this mode, the encoder makes no use of potentially existing 

correlations between the two input channels. It can, however, 

negotiate the bit demand between both channels, i.e. give one 

channel more bits if the other contains silence.

Joint stereo

In this mode, the encoder will make use of a correlation between 

both channels. The signal will be matrixes into a sum ("mid") 

and difference ("side") signal. For quasi-mono signals, this will 

give a significant gain in encoding quality. This mode does not 

destroy phase information like IS stereo that may be used by 

other encoders. This setting can be used to encode DOLBY 

ProLogic surround signals.

Forced Joint Stereo
This mode will force MS joint stereo on all frames. It's faster and 

it uses some special mid and side masking threshold. 

Dual Channels

In this mode, the 2 channels will be totally independently 

encoded. Each channel will have exactly half of the bit rate. This 

mode is designed for applications like dual languages encoding 

(for example: English in one channel and French in the other). 

Using this encoding mode for regular stereo files will result in a 

lower quality encoding.

Stereo

This option will generate a mono file, if the input file is a stereo 

file, the input stream will be down sampled to a mono file by 

averaging the left and right channel. 

 
 
VBR Coding Method
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Coding Method Description

None Do not use VBR, it is encoding with a Constant Bit Rate (CBR).

Default Use the default VBR method (currently set to VBR-MTRH ).

Old
The functional approach, based on masking, bisection in the bit 

domain .

New The approach, based on masking and direct noise allocation .

MTRH A merger of old and new (VBR) routine. 

ABR
The Average Bit Rate (ABR) setting, the encoding principle is based 

on perceptual entropy, but more like CBR than VBR. 

Maximum VBR Bit rate:Allows to specify an maximum bit rate when using VBR (Variable Bit Rate), 

this selecting depends on what base bit rate you have chosen in the main encoder tab. It's 

recommended to leave this set to 320 kbit/s unless you want low quality VBR files. Please do not 

worry if you haven't received the registration information right away. Usually it happens due to too 

secure settings of spam filters used by our clients. And it may happen so that our message is 

rejected as a spam message by the mail service you use.  
 
VBR Quality:In VBR mode, you are able to specify a quality setting which will affect encoding bit 

rate allocation. If you use quality 0, the max bit rate will be reached easily, while using quality 9 the 

bit rate usually will be around the base bit rate. The lower the VBR quality value, the better the 

audio quality, but also the bigger the output file. Recommended setting for high quality VBR 

encoding is 1 or 0. 
 
Write VBR Header:This tag is embedded in frame 0 of the MP3 file. It lets VBR aware players 

correctly seek and calculate playing times of VBR files.  
 
Target bit rate for ABR:The allowed range of the ABR bit rate is 4 - 310 kbit/s, you can use any 

integer value within that range. 

    ` 
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